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1 Welcome

Welcome to the CardExchange® Visitor

Management Help File

1.1 Overview

CardExchange® Visitor Management software allows your organization to take maximum



Welcome 9

© 2016 CardExchange Solutions, Inc.

control and minimize security risks. 

Within a few steps we make it easy to register, authorize, manage, and track visitors. 

Our intuitive interface has a Microsoft look and feel that enables users to navigate our

software with ease. 

Streamline your visitor process and lobby congestion with our pre-registration feature and

provide your visitors a VIP experience. 

Reduce visitor back-log, monitor various types of traffic by categorizing visitors, manage

events, create watch lists to alert of unwanted guests, and more. 

You have all the power you want without the complexity of managing visitors. 

Increase efficiency with maximum control over editing, processing, and output of visitor

data. 

With our badge designer you have all the tools you need to create the perfect card for your

needs in a simple and fun way! 

Built to meet the industry demand for visitor management applications, CardExchange®

Visitor Management software provides a scalable solution to grow and adapt to your

needs.

Streamline your visitor’s...one step at a time!

Feature Highlights

Enter Edition Standard Edition Business Edition

· Unlimited Visitor Records

· Returning Visitor Lookup

· On-Demand Evacuation

Report

· Pre-Register Visitors

· Print Visitor Badges

· View/Print Reports

· Pre-loaded Badge

Templates

· Pre-Register Groups and

Events

· Multiple Images per Record

· Visitor Vehicle Registration

· Badge Expiration Date/Time

· Batch Check-in/Check-out

· ID Scan Record Lookup/

Display

· Scan and Auto Populate

Record

· Quick View Expired Visitor

Lookup

· Customize Record Field

Labels

· User Login Profiles

· Import CSV files

· Import/Export Database

Record Data/Images

· Event Management

· Kiosk Mode/Multiple

Lobbies

· Visitor Watch Lists

· Categorize Event Types

· Multiple Visitor Types

· Visitor Email Notification w/

Barcode

· Non-Disclosure/Company

Agreements

· Biometric Record Lookup/

Display

· Define User and/or Group

Permissions

· Track and Issue Parking

Passes

· SMTP Integration

· Advanced Visitor Reports
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1.2 System Requirements

Speci cations Device Options

Single License Editions:

Windows 7, 8, 8.1, and Windows 10

(32 and 64 bit)

Network (SBS) License Edition:

Windows 2008 R2, and 2012 Server

(32 and 64 bit)

All Editions:

Microsoft .NET Framework 4.6

Dual Core Processor

1024 MB Internal Memory

200 MB Free Disk Space

Internet Connection required for license

activation and use of online help files.

Portable:

Microsoft Surface Pro Tablets

Lenovo Windows Tablets

Printers:

ID Card and Label Printers, Windows Printers

(i.e. laser or deskjet)

Capture:

Cameras, Signature Pads

Scanners and Readers:

ID Scanners, Biometric Devices, Barcode

Scanners, Contactless Readers

For specific device and model information,

please visit our

website.

1.3 FAQ

This page contains a selection of our most common and frequently asked questions...

· How can I activate a CardExchange® Visitor license?

· What should I do if activation fails?

· How do I create or edit my badge layout?

· How can I add a Photo to my badge layout?

· How can I capture an ID photo for a visitor?

· How can I capture a signature?

· Which Cameras are supported by CardExchange® Visitor?

· Which Signature Pads are supported by CardExchange® Visitor?

· How can I show a variable image on the card layout?

15

100

245

59

76

247

https://cardexchangesolutions.com/id-card-software-support/license-activation
https://cardexchangesolutions.com/id-card-software-support/cardexchange-devices/cardexchange-cameras
https://cardexchangesolutions.com/id-card-software-support/cardexchange-devices/cardexchange-signature
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· How can I configure magnetic encoding?

· How can I protect CardExchange® Visitor with user names and passwords?

· How can I find answers to specific questions about CardExchange® Visitor (forum)?

· Using GDI+ printing technology when printing results are poor.

· How to use ID scanners with CardExchange® Visitor.

· What are the colored circles for next to the visitors name?

· How do I add a new visitor?

· How do I create a new event?

· How can I import or export data?

· How do I use filters to show me checked-in visitors?

· How do I manage expired badges?

· How do I generate an Evacuation report?

· How do I view and print visitor reports?

192

104

182

35

32

34

122

56

46

272

274

151

https://forum.cardexchangesolutions.com
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2 Getting Started

To get started with CardExchange® Visitor, it is important to get familiarized with the

interface. 

CardExchange® Visitor has two main interfaces:

· The Main Interface offering the Visitors view, the Events view etc..

· The Configuration Interface, the Card designer.

Most of the time you will be working from the main interface, shown above is the Visitors

view.
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And we then have the Card Designer.

2.1 Our Trial Edition

Our CardExchange® Visitor Trial Version offers you unlimited access to all available

functionality within our editions for a period of 30 dayds. When you have installed

CardExchange® Visitor for the first time, just select "Evaluate CardExchange® Visitor" and

select the edition that you want to try out.
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We offer the possibility to try out our Enter, Standard and Business editions. For information

about the offered functionality per edition, check out our Overview  section in this Help

File.

When you have made your selection from the drop down menu, simply click on Finish to

start your trial and use all functionality offered. The only limitation of the Trial is that it

prints DEMO on the card and on any reports. The nice part is, when you have configured,

designed etc., and you like our CardExchange® Visitor application, you simply purchase a

license, activate it, and you keep on working. Nothing needs to be redone!

Activating your Trial or your new installation is explained in our Activation and Registration

 section of this Help file.

8

15
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2.2 Activation and Registration

When you have used our Demo Edition and you want to use it, or you directly purchased

our CardExchange® Visitor application via one of our resellers, you will have to activate the

application. 

To activate CardExchange® Visitor you need to have a Serial Number and Activation

Code.

The serial number is a five (5) digit number and looks like 23144. The activation code is a

24 digit number and looks like 017DF-116DA-1ABA4-DDF80-CF05F-32D99-371F.

Activating your license is very easy to do. Just start your new installed CardExchange®
Visitor application or start your Trial Edition.
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Select the "Activate CardExchange® Visitor" option and click on the Next button.

Enter your serial number and activation code.

The Machine ID is unique for each computer that CardExchange® Visitor is installed on and is used for activating the license
and to identify your computer by our licensing system. The Machine ID is generated based on your internal computer hardware.
If activation fails because you have, for example, no internet connection on your computer, your license can also be activated
directly via our website but to activate your license via our website, you need to have this unique Machine ID. For more
information about activating your license, please view our Video Section on our website where you can find helpful videos about
installing and activating CardExchange® Visitor.

When you have entered your license information, you click on Activate to start the

Activation process.

At the moment the activation process starts, you can start registering your license.

Registering your license offers a lot of benefits. It offers access to our End-User Help Forum,

http://www.cardexchangesolutions.com/our-downloads/videos-downloads.html
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it informs you about new releases and updates, etc. 

In the registration page you can enter all your company and contact information. The fax

number is optional, all other fields are required. Select the printer brand you are using, the

type of company, and in which language you prefer to communicate. Last but not least,

provide an Alias for our End-User Forum. Standard your alias is the same name as the name

of the contact person, but you can change this to something else if you do not want to have

your name shown in the forum with your post.

IMPORTANT! Your provided information will never be commercially sold and will only be used by CardExchange® Solutions and
your reseller to provide you with important information about your software and hardware!

When you have provided all information, click Next to proceed to the next page of the

registration.
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In this page of the registration process you can first indicate if you want to use 30 days of

all functionality available in CardExchange® Visitor, the Enterprise edition. This can be

handy if you have, for example, received an Enter edition. Selecting this 30 days trial will

offer you an insight to available functionality to determine which edition fits your situation

best before buying. All trial functionality will be clearly indicated as TRIAL.

If you would like to be contacted, just select how and when, and your reseller will contact

you on the preferred date selected.

Last but not least, subscribing to our newsletter offers you information specific for your

software and hardware that you are using.

Click Next to proceed to the Final page of the registration process.
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During the registration process, your CardExchange® Visitor license has been activated.

Click on Finish to finalize the activation and registration and start CardExchange® Visitor.

For more information about updating your registration, please visit our "Update Your

Registration Info"  section of this Help file. Want to upgrade your license to a higher

edition, please visit our "Upgrade Your License"  section of this Help file.

162

158
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2.3 Data Folder

During the installation of CardExchange® Visitor you are asked to select a location for your

Data folder. By default this folder is installed in the Public Documents folder under

VisitorExchange.

The Data folder of CardExchange® Visitor contains the database of all your settings,

visitors and events.
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Alongside this Data folder is a Templates folder and a License folder. The Templates folder

is where the default template is stored along with any additional templates you create.

The License folder contains the license file that is unique for that individual PC.

We strongly advice to make regular backups from this VisitorExchange folder especially

when you have made changes in your configuration.

When your computer crashes and you need to reinstall CardExchange® Visitor, after the

installation and re-activation, you copy the backup of the VisitorExchange folder back, start
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CardExchange® Visitor and all your configurations are restored and you can start working

directly again.

2.4 Main Interface

The main interface of CardExchange® Visitor is split into different views available at the

bottom of the window, the same as in Microsoft Outlook.
Selecting each view changes the view as well as the ribbon options. 

Shown above is the Visitors view.
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Above is the Events view.

Above is the Reports view.
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And the Assist view.
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3 Working With Visitors

In the Visitors view you can carry out all the operations associated with Visitors, you can

add/edit visitors, Check-in/Check-out visitors, add Events etc...



CardExchange® Visitor Manual26

© 2016 CardExchange Solutions, Inc.

3.1 Layout

The Visitors view has four panes that can be moved, resized or hidden based on the users
preferences.

· The Visitors pane (Shown above in red) shows a list of all the visitors.

· The Badge preview pane (Shown above in blue) shows the preview of the visitor badge with the
selected visitors details.

· The Visitor details pane (Shown above in black) shows all the available data for the selected
visitor including photo/signature.

· The Actions pane (Shown above in green) contains shortcuts to the most common actions such
as Check-in, Check-out and Print badge.
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3.1.1 Visitors Pane

In the Visitors pane of CardExchange® Visitor you see all the records presented that are

available in the database. In the configuration tab you can set the Look-up columns that are

displayed in the Visitors pane.

Also shown here is the current status of the visitor shown by the colored circle next to their

name.

These status markers show whether they are currently checked-in/checked-out, pre-

regestered for an event etc...

For more info please see the Status Markers  section.

Record Sorting

32
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The Visitors pane is a so called data grid showing all your available database records

divided by columns. Sorting the records is just as simple as clicking on the column. 

Record Look Up

It is very simple to search for records inside the Visitors pane. Enter the text that you want
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to search for in the text box directly above the columns. The text you enter always applies

to the first column in the Visitors pane. If you want to look up records from the Last name

column, you have to drag the column to the front. 

Loaded Record Information

In the footer of the Visitors pane the total amount of loaded records is shown.
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3.1.2 Badge-Preview Pane

The Badge preview shows a live preview of the visitors badge with the data from the

selected visitor.

3.1.3 Visitor Details Pane

The Visitor details pane shows all of the database fields for the selected visitor including
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their photo and signature.

From the configuration tab you can select Detail columns to customize which fields you

want to make available here.

Also shown is the current status of the visitor in a colored status bar, for example above the

visitor is showing as currently checked-out.

For more info please see the Status Markers  section.

3.1.4 Actions Pane

In the Actions pane, located at the right side of the main interface, seven

different buttons can be shown. 

Clicking New visitor will bring up the New visitor window so you can enter the

visitor details.

Clicking Check-in will directly check-in the selected visitor(s).

Clicking Check-out will directly check-out the selected visitor(s).

Clicking Blacklist will add the selected visitor(s) to the blacklist to prevent them

from being able to be checked in.

When clicking on the Take photo button, the camera that is selected will be

previewed in the PhotoExchange window. Configuration of the Photo

functionality is explained in the "Using Photos " section of this Help file.

If you have the Standard edition or higher, the Capture signature button is show.

When clicking it will start the signature pad connected. In the "Use Signatures "

section of this Help file you can find out how to configure this functionality.

Clicking Print badge will print the visitor badge for the selected visitor(s).

32

59

75
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3.1.5 Status Markers

The current status of a visitor is shown in two places:

· By the colored circle next to their name in the visitors pane 

· By the colored bar down the right hand side of the visitor details pane

These status markers show whether they are currently checked-in/checked-out, pre-

regestered for an event etc...

We have the following statuses:

Current Status Status Marker Status Bar

text

1 Checked-out and not pre-registered Green circle OUT

2 Checked-in for an incidental visit Blue circle IN

3 Checked-in for an incidental visit and expired Blue circle with blue
cross

EXPIRED

4 Checked-out and pre-registered, but not yet
allowed to check-in

Orange circle PRE-
REGISTERE
D

5 Checked-out, pre-registered and allowed to
check-in

Orange circle with
green spot

PRE-
REGISTERE
D

6 Checked-in for a pre-registered event Orange circle with a
blue spot

IN

7 Checked-in for a pre-registered event and
expired

Blue circle with orange
cross

EXPIRED

8 Blacklisted while still checked in (precedes
over 2, 3 and 6)

Blue circle with red
cross

BLACKLIST
ED

9 Blacklisted and checked-out (precedes over
1, 4, 6 and 7)

Red circle BLACKLIST
ED
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The idea is that the user easily recognizes that:

· All visitors with green in their icon are ready to check-in
· All visitors with blue in their icon are in the building
· All visitors with orange in their icon are pre-registered
· All visitors with red in their icon are blacklisted
· All visitors with a cross should leave the building

3.2 Home
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From the Home tab of the Visitors view it is possible to carry out the most common

functions required in the use of CardExchange® Visitor. 

In this section of the Help file we will go over all the functionality available like adding

visitors/events, using Filters, checking-in and checking-out, etc.

3.2.1 New visitor

Clicking on New visitor will open the New visitor window.

Here you can enter all the details for the visitor, capture their photo, signature and

biometric image (Depending on your edition).

You can also populate the fields by clicking on Scan document  and scanning the visitors

drivers license or passport.

The First name and Last name fields are required fields, the others are all optional.

You can then either click on Save, Save & check-in or Cancel.

35
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Clicking on New item gives you the choice of creating a new visitor or a New event .

3.2.1.1 ID Scan

You can populate the fields for a new visitor by clicking on Scan document and scanning

the visitors drivers license or passport.

Simply select the document options shown in red and the region options shown in blue,

then click on Scan.

122
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Once scanning is complete click on Process and the data will be extracted as shown above.



Working With Visitors 37

© 2016 CardExchange Solutions, Inc.

Clicking on Save & Exit will create the new visitor and display the Visitor details pane where

you can add/edit any other information.
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3.2.2 Visitor Groups

Visitor groups can be created so that all visitors within that group can be managed

together. 

When used with the Group filter from the Filters  section, the status of all visitors within

that group can easily be seen in the main CardExchange® Visitor window without looking

up each visitor individually.

You can also check-in/check-out all visitors within that group as one action instead of

individually.

The simplest way of searching for an existing group to edit, is to use the group list that is

displayed at the left-hand side of the Visitor groups window. You can use the scroll bar to

scroll through the list to find the correct group and then select it by clicking. The group list

may be sorted in various ways and is not necessarily alphabetical. You must take this into

account when searching for a group.

In the groups list you will see all of the groups that are available in the database. In the

Layout section of the ribbon you can set the Look-up columns that are displayed in the

46
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group list.

Group Sorting

The group list is a so called data grid showing all your available groups divided by

columns. Sorting the groups is just as simple as clicking on the column. 

Group Look Up
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It is very simple to search for groups within the group list. Enter the text that you want to

search for in the text box directly above the columns. 

Loaded Record Information

In the footer of the group list the total amount of loaded records is shown.

You will notice that this method becomes less attractive if the list is very long and that you

need a more directed manner of finding the correct data. Another option for finding

groups is to use the Find section of the ribbon as mention in the following section.
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3.2.2.1 Find

In the Find section you can search for groups to easily find them. If you click on Find, you

enter a dialog window in which you can enter a combination of letters or digits to search

on (only alphanumeric characters).

If you then click OK, the first element from the list of names that contains the requested

combination is selected.

If the first match is not the one you are looking for, you can search on the same

combination by clicking the Find next button. You can repeat this until you have found the

correct person.
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The advantage of searching in this way is that the text you enter does not need to be at the

start of an element in the groups list. The search does not make a distinction between

uppercase and lowercase characters.

With this Find function, all elements in the groups list remain visible. Any restrictions to the

number of records that are displayed, which would normally apply as a result of what you

have entered in the text field, are overruled.

The find functions are also available from the keyboard. You can display the window Find

by simultaneously pressing the control key and the letter f. You can repeat the search as

often as is required to find the correct person by pressing the F3 function key.

3.2.2.2 Adding Visitor Groups

To add a new group, simply click on the New button. You can now specify a name and

description for the group.
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Once you have done that you need to add some visitors to the group, to do this click on the

Select visitors button.

You can search fo visitors and then add or remove them from the group using the Add/

Remove buttons.

Once you are done you can click on Accept or Cancel and you will go back to the previous

window.
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The last step is to click on Save to save the new group, you can also edit groups using the

same method above to add/remove visitors.
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3.2.2.3 Layout

Under the Layout section of the ribbon it is possible to edit the column attributes, as well as

the look-up columns and detail columns that are displayed.

3.2.3 Edit

In the Edit section you have options to Edit visitor , Delete visitor  and Visitor groups

.

54 55
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3.2.4 Filters

The filters section allows you to filter the list of visitors that is shown in the visitors pane.

The following filters are available and can be used in combination with each other:

All visitors This is the default option and shows all visitors in the database

Checked-in visitors Shows all visitors currently checked-in

Blacklisted visitors Shows all visitors that have been flagged as blacklisted

Preregistered visitors When checked only Preregistered visitors will show

Events Select from the available events to only show those visitors (The

default is all events)

Groups Select from the available groups to only show those visitors (The

default is all groups)

3.2.5 Actions

The actions section allows 

Check-in Clicking Check-in will directly check-in the selected visitor(s).

Check-out Clicking Check-out will directly check-out the selected visitor(s).

Blacklist Clicking Blacklist will add the selected visitor(s) to the blacklist to

prevent them from being able to be checked in.

Print badge Clicking Print badge will print the visitor badge for the selected

visitor(s).



Working With Visitors 47

© 2016 CardExchange Solutions, Inc.

3.3 Data

Viewing and Managing data from the database is very important, CardExchange® Visitor

offers many ways to look up data, enrich data, view data, etc.

In this section of the Help file we will go over all the functionality available like searching

for and editing visitors, etc.

3.3.1 Record Lookup

The simplest way of searching for the correct record is to use the Visitors pane  that is

displayed at the left-hand side of the main window. 

You can use the scroll bar to scroll through the list to find the correct record and then select

it by clicking. 

The Visitors pane  may be sorted in various ways and is not necessarily alphabetical. You

must take this into account when searching for a record.

27
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In the Visitors pane of CardExchange® Visitor you see all the records presented that are

available in the database. In the configuration tab you can set the Look-up columns that are

displayed in the Visitors pane.

Record Sorting

The Visitors pane is a so called data grid showing all your available database records

divided by columns. Sorting the records is just as simple as clicking on the column. 

Record Look Up
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It is very simple to search for records inside the Visitors pane. Enter the text that you want

to search for in the text box directly above the columns. 

Loaded Record Information

In the footer of the Visitors pane the total amount of loaded records is shown.
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You will notice that this method becomes less attractive if the list is very long and that you

need a more directed manner of finding the correct data. The following alternative find

methods are available:

· Finding names using the Find section in the Data tab,

· Finding names using the Keyboard

· Finding names using the Database Filters

The first two methods will be explained in the following sections. For an explanation of the

database filters, please refer to the section Filters  of this Help file.

3.3.1.1 Using Find

In the Find section of the Data tab you can find the functionality Find. If you select this

option, you enter a dialog window in which you can enter a combination of letters or digits

to search on (only alphanumeric characters).

If you then click OK, the first element from the list of names that contains the requested

combination is selected.

If the first match is not the one you are looking for, you can search on the same

combination by clicking the Find next button in the Find section of the Data tab. You can

repeat this until you have found the correct person.

The advantage of searching in this way is that the text you enter does not need to be at the

start of an element in the events pane. The search does not make a distinction between

uppercase and lowercase characters.

46
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With this Find function, all elements in the Visitors pane  remain visible. Any restrictions

to the number of records that are displayed, which would normally apply as a result of what

you have entered in the text field, are overruled.

3.3.1.2 Using Keyboard

The find functions that have been discussed in the section Using Find  are also available

from the keyboard. You can display the window Find by simultaneously pressing the 

control key and the letter f. You can repeat the search as often as is required to find the

correct person by pressing the F3 function key.

3.3.1.3 Refresh Data

It is possible that you cannot find the intended record because it has only just been entered

into the database. The details of the record in question have already been entered into the

database, but CardExchange® Visitor has not yet, as it were, seen it. You can solve this

problem by selecting the Refresh data option in the Find section (or by pressing the F5

function key). CardExchange® Visitor will retrieve the list of records from the database

again.

Doing this ensures that the most recent data for the record concerned is displayed.

3.3.1.4 Scan Search

It is also possible to search for records by scanning their ID, simple click on Scan search and

present their ID to be scanned into the ID scanner.

If a match is found in the database their record will be selected in the Visitors pane and

their details displayed in the Visitor details pane, if not you will have the option to add the

visitor.

27
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After clicking Scan search the ID scan dialog will show, simply confirm the Document

options highlighted in red and the region options highlighted in blue then click Scan.

Once scanning has completed the dialog will close.
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If a match is found then the visitor will be selected in the Visitors pane and their details

shown in the Visitor details pane.

If no match is found then you will be asked if you want to create a new visitor.
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Clicking yes will add the new visitor and select them in the Visitors pane.

3.3.2 Editing Visitor's

Visitor details can be edited in four steps:

· First select the visitor from the Visitors pane that you wish to edit.

· Then either click on Edit visitor from either the Data tab or the Home tab.

· Click on the field you want to edit and change it. Instead of using the mouse, you

can also use the Tab key to move through the desired fields. The buttons Save and

Cancel will be enabled as soon as you start typing.

· Click on the Save button to save the data into the database, or on the Cancel

button if you do not want that.
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If you clicked on Edit visitor by accident, or you decided that a change was not required

you can simply click on the Back button.

3.3.3 Deleting Visitor's

A database record can be deleted in three steps:

· First select the visitor from the Visitors pane that you wish to delete.

· Then either click on Delete visitor from either the Data tab or the Home tab.

· Say Yes to the question if you really want to delete the record. Say No if you do not

want that.
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Visitors can only be deleted if they have not been checked-in, once they have been

checked-in or assigned to an event they cannot be deleted.

If you try to delete a visitor that has already been checked-in or assigned to an event you

will get the above message.

3.3.4 Import or Export

CardExchange® Visitor offers the possibility to import and export visitors as well as
photos/signatures.

Exporting Visitors

When clicking on Export visitors you will be prompted to select the location for the csv file
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to be saved, clicking on export will then export all of the records into the csv.

Importing Visitors

When clicking on Import visitors you will be prompted to select the location for the csv file

to be imported from, once selected any matching column headers found in the csv file will

be mapped to the corresponding fields in the database. You will also see examples from

the first few entries in the csv file so you can make sure the data is matched to the correct

columns.

Any column names that do not match those withing the CardExchange® Visitor database

will show as unmapped, you can then click on map to choose the desired column to map

them to.
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Simply select the desired field from the database and click on add to map the csv column

to this field.

Exporting Images

When clicking on Export images you will get the choice of images to export (Photos/

signatures etc..) and you can choose the image location to export them to.

Images are exported in the .jpg file format.

Importing Images

When clicking on Import images you will get the choice of images to import (Photos/

signatures etc..) and you can choose the image location to export them from.
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3.4 Photos

In this section of the help file you can find all the information of how to use photos with

CardExchange® Visitor.

3.4.1 Options

Under the options section there are three options depending on your edition.

Use image editor Automatically display the image editor after

capturing the photo

Ask for confirmation Ask for confirmation before storing the captured

photo

Use FaceFind Use the FaceFind option automatically crop the photo

to the persons face 

FaceFind is only available from the CardExchange® Visitor Standard edition.

3.4.2 Take Photos

When you have selected the correct record, you can add a photo of the person to the

database, or, if you want, replace the existing photo. This function is accessible in the
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following ways.

· Click Take photo button in the photos tab of the ribbon,

· Click Take photo button in the Actions pane,

· Click on the Take photo icon when adding/editing a visitor.

After you have taken the photo, you will enter the Image Editor window of CardExchange®

Visitor, ImageExchange®.
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Please see the Using Image Tools  section of this Help file for more information about

using the ImageExchange® Image Editor.

If you click on the OK button, the photo will be automatically cropped and the Image

Editor will be closed. If a photo was already available in the database, CardExchange®

Visitor asks whether you want to update it. If you click Cancel, the original photo will be

restored on the print preview. You can disable this option in the Photo tab by unchecking

the Use Image Editor check box.

3.4.2.1 PhotoExchange

When taking a photo the PhotoExchange window will be shown to handle the acquisition

of the image from the connected camera.

PhotoExchange is a separate utility where you can manage the connected camera, camera

settings and view a preview of the image to be captured.

72
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The Preview tabs shows a live preview from the selected camera.
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If you are using a supported Canon camera then then some of, or all of the options under

the Canon tab will be available depending on the camera model.
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The Direct Show tab shows the settings for any Direct Show device such as webcams
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Under the FaceFind tab you can enable/disable automatic face recognition and cropping,

you can also change some settings relating to zoom and position.
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And under the Devices tab you can select the connected device.

3.4.3 Import Photos

It is possible that you do not want to take a photo of someone because you already have

his/her photo. If this photo is in one of the usual formats (bitmap, jpeg, png, etc.), you can

use the Import photo function indicated to import it and store it for the selected record in

CardExchange® Visitor.

This function is accessible in the following ways.

· Click Import photo button in the photos tab of the ribbon,

· Click on the Import photo icon when adding/editing a visitor.
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If you click Import photo, you enter a dialog window that allows you to select the photo

file.

If you have found and selected the file, click Open and the photo will be displayed in the
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Image Editor  window. Here you can crop the photo to the right size and perform any

other editing operations.

3.4.4 Edit Photos

Photos that were taken earlier can be edited using Image Editor. This function is accessible

in the following ways.

· Click Edit photo button under the photos tab of the ribbon,

· Click on the Edit photo icon when adding/editing a visitor.

After clicking on edit image you will enter the Image Editor window of CardExchange®

Visitor, ImageExchange®.
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Please see the Using Image Tools  section of this Help file for more information about

using the ImageExchange® Image Editor.

If you click on the OK button, the photo will be automatically cropped and the Image

Editor will be closed. If a photo was already available in the database, CardExchange®

Visitor asks whether you want to update it. If you click Cancel, the original photo will be

restored on the print preview. You can disable this option in the Photo tab by unchecking

the Use Image Editor check box.

3.4.5 Export Photos

The opposite to import photo is also possible. You can export an existing photo from the

database to a file. To do this, click the Export photo button indicated in the Actions

72
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section. Once more a dialog window will be displayed in which you can specify the name

and location of the file that must contain the photo.

You can choose the following supported file formats: Bitmap, jpg, emf, gif, png, and tiff.

Click on Save and the photo is exported to the selected location.

3.4.6 Remove Photos

Photos can be removed from the database by clicking the Remove photo button from the

Actions section indicated. The user will be asked to confirm the remove operation with the

following question.

This function is also accessible by clicking on the Remove photo icon when adding/editing

a visitor.
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When you click Yes, the photo will be removed from the database.

3.4.7 Copy and Paste

The Actions - Copy photo option allows you to copy the photo displayed to the photo

clipboard of CardExchange® Visitor. You can then choose another record and, by using the 

Paste photo option, link the photo on the clipboard to the selected record.

This function can be handy if the same record must be entered under a different name or

company in the database. You do not need to take a new photo. As long as you do not
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copy another photo and do not shut down CardExchange® Visitor, the copied photo will

remain on the clipboard.

3.4.8 Using Image Editor

CardExchange® Visitor offers for all editions an Image Editor tool, ImageExchange®. The

ImageExchange® tool offers some interesting functionality to help you upscale your

photos or images.

When you take a photo or capture a signature and the Use Image Editor option is

checked, this ImageExchange® tool will open. It also opens if you click on the Edit photo

button.

ImageExchange® has functionality available via the File menu and the ribbon.

The File Menu
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When you take a photo, capture a signature, etc., the image will be automatically be show

in the ImageExchange® tool. It is also possible to Load another image via the Load

function in the File menu.

When the image is edited and you click on OK, the image will be saved automatically. If

you want to store the image to another location just click on Save and select the

destination in the File Explorer and click on Save.

Exit just closes the ImageExchange® tool without saving and works as the Cancel button.

Overview of the Ribbon

When the image is loaded, you can apply some standard functionality to it. If the image
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needs to be rotated, just click on the Left or Right buttons in the Rotation section.

You can also crop the loaded image when you have adjusted the size.

When you move the rectangle to required size, and you click on Crop, the image will be

cropped according to the settings made.

When you click on the Black and white button, the whole image is converted to Black and

White and of course you can undo all your settings by clicking on the Undo button or click

on Reset to go back to the original loaded image.

Brightness and Contrast
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Move the sliders indicated to change the Brightness and/or Contrast of the loaded image.

Click on OK to store the image or click on Cancel.

3.5 Signatures

IMPORTANT! Signatures are supported starting from Standard and higher editions!

In this section of the help file you can find all the information of how to use signatures with

CardExchange® Visitor.
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3.5.1 Capture Signatures

When you have selected the correct record, you can add a signature of the person to the

database, or, if you want, replace the existing signature. This function is accessible in the

following ways.

· Click Capture signature button in the ribbon as indicated,

· Click Capture signature button in the actions pane,

· Click on the Capture signature icon when adding/editing a visitor.

After you have captured the signature , you will enter the Image Editor window of

CardExchange® Visitor, ImageExchange®.
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Please see the Using Image Tools  section of this Help file for more information about

using this ImageExchange® Image Editor.

If you click on the OK button, the signature will be automatically cropped and the Image

Editor will be closed. If a signature was already available in the database, CardExchange®

Visitor asks whether you want to update it. If you click Cancel, the original signature will be

restored on the print preview. You can disable this option in the Signature tab by

unchecking the Use Image Editor check box.

3.5.2 Edit Signatures

Signatures that were captured earlier can be edited using Image Editor. This function is

accessible in the following ways.
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· Click Edit signature button in the ribbon as indicated,

· Click on the Edit signature icon when adding/editing a visitor.

After clicking on Edit signature, you will enter the Image Editor window of CardExchange®

Visitor, ImageExchange®.
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Please see the Using Image Tools  section of this Help file for more information about

using the ImageExchange® Image Editor.

If you click on the OK button, the signature will be automatically cropped and the Image

Editor will be closed. If a signature was already available in the database, CardExchange®

Visitor asks whether you want to update it. If you click Cancel, the original signature will be

restored on the print preview. You can disable this option in the Signature tab by

unchecking the Use Image Editor check box.

3.5.3 Copy and Paste

The Actions - Copy signature option allows you to copy the signature displayed to the

signature clipboard of CardExchange® Visitor. You can then choose another record and, by

72
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using the Paste signature option, link the signature on the clipboard to the selected

record.

This function can be handy if the same record must be entered under a different name or

company in the database. You do not need to capture a new signature. As long as you do

not copy another signature and do not shut down CardExchange® Visitor, the copied

signature will remain on the clipboard.

3.5.4 Import Signatures

It is possible that you do not want to capture a signature of someone because you already

have his/her signature. If this signature is in one of the usual formats (bitmap, jpeg, png,

etc.), you can use the Import signature function indicated to import it and store it for the

selected record in CardExchange® Visitor.

This function is accessible in the following ways.

· Click Import signature button in the photos tab of the ribbon,

· Click on the Import signature icon when adding/editing a visitor.
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If you click Import signature, you enter a dialog window that allows you to select the

signature file.

If you have found and selected the file, click Open and the signature will be displayed in

the Image Editor  window. Here you can crop the signature to the right size and perform72
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any other editing operations.

3.5.5 Export Signatures

The opposite to import signature is also possible. You can export an existing signature from

the database to a file. To do this, click the Export signature button indicated in the

Actions section. Once more a dialog window will be displayed in which you can specify the

name and location of the file that must contain the signature.

You can choose between two supported file formats: Bitmap, jpg, emf, gif, png, and tiff.

Click on Save and the signature is exported to the selected location.
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3.5.6 Remove Signatures

Signatures can be removed from the database by clicking the Remove signature button

from the Actions section indicated . The user will be asked to confirm the remove

operation with the following question.

This function is also accessible by clicking on the Remove signature icon when adding/

editing a visitor.

When you click Yes, the signature will be removed from the database.
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3.6 Biometrics

IMPORTANT! Biometrics are supported starting from Business and higher editions!

In this section of the help file you can find all the information of how to use Biometrics with

CardExchange® Visitor.

3.6.1 Biometric options

In the Biometric options you can choose either Digital Persona or Topaz devices depending

on the hardware you have.
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3.6.2 Enroll Biometric

When clicking on enroll Biometric you will be prompted to place finger on the reader, once

scanned you can click on ok to proceed.

3.6.3 Biometric Search

When clicking on Biometric search you will be prompted to place finger on the reader,

after a successful read it will attempt to look up the matching record from the database. If
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sound the record will be displayed.

If no matching record is found the below message is shown, you can then proceed to enroll

the new visitor if you wish using the enroll biometric option.

3.6.4 Remove Biometric

If required, you can also remove the stored biometric template from the database.
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3.7 Configuration

Under the configuration tab you can set some advanced options, create/edit the visitor

badge design, change settings for the database columns and setup authorizations.

3.7.1 Advanced Options

Clicking on Advanced Options will show a window where you can changes some advanced

settings of CardExchange® Visitor.
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In the Advanced Options window you can set the requirements for each separate discipline

of the application, just simply select the tab and change the settings. In this section we

explain what the settings are for and how to configure them.
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3.7.1.1 General

Enable

automatic

checkouts

When selected and closing the application, a window will be shown with

the current checked in visitors so they can be checked out.

Show service-

center errors

This is a debug setting when no content is shown inside the Assist portal.

Standard this is disabled and has no influence on the main application.

Show a

visitor's

additional

needs at check

in

Some visitors have special needs like disabilities, VIP, or need to be

escorted, when incidental check-in's are done, it can be handy to know this

before checking in. When this option is checked, the needs will be shown in

the check-in confirmation window.

Print behavior This applies to printing reports. You can select here if you want to show a

preview of the report first, directly open the print dialog, or send the report

directly to the last selected printer.

Confirm

incidental

check-ins for

Here you can select if you want to have a confirmation before check-in, or

not, and if so, for who. 

Deny incidentalHere you can select what type of visitor is denied to check-in, when you
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check-ins to select all preregistered visitors, they can only check in to the preregistered

event and not as an individual visitor.

Require badge-

expiration

dates for

Badge expiration notices are handy to keep track of who is overstaying in

your premisses. You can select here who will receive a badge expiration

date.

Detail-editor

width (pixels)

Set the length of your text boxes, drop down menus, etc., in all the

windows that can edit and contain person information.

Invitee history

(days)

Enter the amount of days you want to the history of a visitor. By default 7

days is shown.

Default event-

start-date

interval

(minutes)

Determines how many minutes after the current time should the event

start. By default this is 0.

Default event-

end-date

interval

(minutes)

Determines how many minutes after the start time time should the event

end. By default this is 60.

Default early-

check in-date

interval

(minutes)

The default number of minutes before the start date occurs, that users are

allowed to check-in for an event. By default this is 30.

Default badge-

expiration-date

interval

(minutes)

The default number of minutes after the end date occurs, that the badges

will expire. By default this is 30.

Default event

organizer

Select the default event organizer for new events.

Update-timer

interval

(seconds)

The time interval in seconds that determines how often changes made by

others are uploaded to the current installation. By default this is 300.
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3.7.1.2 Lobbies

Location options:

My building Here you can select the name of the building that the
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current installation is in

My lobby Here you can select the name of the lobby that the

current installation is in

Filter options:

Do not apply any filter on

buildings or lobbies at start-up

Select this option to show all visitors/events at start-up

(Default)

Filter on my building at start-up Enable the building filter at start-up to only show

visitors/events for the current building

Filter on my lobby at start-up Enable the lobby filter at start-up to only show visitors/

events for the current building

Check-in options:

Allow check-ins for any building

and lobby

Select this option to allow check-ins for all visitors/

events (Default)

Only allow check-ins for my

building

Allow only check-ins for the current building

Only allow check-ins for my lobby Allow only check-ins for the current lobby
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3.7.1.3 Documents

Check-in document options

Document printing allows

continuation of check-in

When checked, printing of the document to be physically

signed will allow the check-in process to continue

View signed documents after

completing check-in

When checked, documents signed digitally will be shown

after completing check-in

PDF options

Each document is saved as an encrypted PDF. When attempting to open one of these

documents, a prompt is shown asking for a password to be entered. 

Two types of passwords can be entered: Document Open Password or Owner Password.

Depending on which is entered, different permissions are granted.

Owner password: All permissions (modifying, copying, standard and high-resolution

printing, content accessibility) [default: “owner”]

Document Open Password: No permissions [default: “password”]
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Here you can change the default password for both options.

3.7.1.4 Screening

CardExchange® Visitor Business Edition is offering visitor screening via criminal and sex

offender database systems of Amber Road and MK Data Services. CardExchange Solutions

does not provide subscriptions for these screening services. 

To use these services, a separate subscription will have to be purchased from these

companies. For all available services we offer direct links to their websites.

When you are using visitor screening with the Business edition, and you have obtained a

subscription for these services, you can define in this window how the services apply to your

situation. As default, the screening will always be done before check in.

You can set the screening during check in, when you add invitees to an event, or when you

register an new visitor.

You can also specify how long the screening result will be valid for, by default this is 30

days but you can set this to your desired interval or you can set it to 0 to screen the visitors

every time.
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3.7.1.5 Email

CardExchange® Visitor Business Edition is offering email notifications to each Invitee of an

event when the event is created, also an email notification is sent to the host of the event

each time an invitee checks in to that event.

In this section you can enable email notifications and specify the SMTP server settings

along with the messages that are sent.
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3.7.1.6 KIOSK

The CardExchange® Visitor Kiosk Client can be configured from a standard

CardExchange® Visitor client installation.

There are options for the general setup and also the the setup of the assistants which will

guide the visitor through the check-in process.

In the general setup you can change the Administrator password for the kiosk client

(Default = Admin), you can set the default timeout value and you can disable the key

combination that can be used to exit the Kiosk Client (ALT+F4).

You can also select the logo to be displayed on the kiosk screen, a preview is shown so you

can check it.

You can also select the identification options that you want to be available for visitors to

use when checking in.

By default barcode scanning is selected, but you can also select Id scanning if you have a

compatible ID scanner.
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3.7.1.6.1  KIOSK - Check-in Assistants

For each step in the check-in process you have a number of options available, you can also

choose not to use certain steps if you have no need for them.

You can specify that a video should be played and that it needs to be accepted by the

visitor before they can complete the check-in process, this could be for example a health

and safety video or a fire safety video.

You can specify the location for the video along with a message that is displayed.

For each step you can specify whether each available Database field is visible and whether

or not it should accept input from the visitor.

You can also specify the same options for the check-out summary step.
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3.7.2 Visitor Screening

CardExchange® Visitor Business Edition is offering visitor screening via criminal and sex

offender database systems of Amber Road and MK Data Services. CardExchange Solutions

does not provide subscriptions for these screening services. To use these services, a

separate subscription will have to be purchased from these companies. For all available

services we offer direct links to their websites.

If you have purchased a subscription for one of the supported services, you will receive

credentials that will have to be entered into CardExchange® Visitor. To enter the

credentials, click the Visitor Screening button in the Configuration tab and the Visitor

Screening window, as shown below, will open:

Select the tab offering the services that you subscribed too, enter the credentials, and login:
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When you are using visitor screening with the Business edition, and you have obtained a

subscription for these services, you can define in this window how the services apply to your

situation. As default, the screening will always be done before check in.

Before the person is checked in, information of the person will be sent to the screening

services and when a possible match is made, the window below will be show:
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Continue will check the person in, Blacklist will put the person on the Blacklist of the visitor

management system, etc.

You can set the screening during check in, when you add invitees to an event, or when you

register an new visitor.

The system will continue to be logged in until you disable. When and how you screen your

visitors can be defined in the Advanced Options window .

3.7.3 Cards

Under the cards section you can load the Card Designer  to edit the existing layout, you

can also create a new card, select another existing card or remove the selected card.

94
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3.7.4 Layout

Under the Layout section of the ribbon it is possible to edit the column attributes  such

labels, font sizes, text masks etc. as well as select the look-up columns and detail columns

that are displayed.

You can also configure drop-down values  to be used for columns where data entry is

always from a selection of values.

3.7.4.1 Drop-down Values

It is possible to configure drop-down values to be used for columns where data entry is

always from a selection of values.

For example you could use a field in the database to record if a visit was planned or not,

then instead of typing manually each time you can select from the available options in a

drop-down list.

103
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In the example above we have used the ExtraTextField1 field in the database, changed the

label to be Visit Type, changed the field to be a Drop-down list and set the drop down

properties to the drop-down settings that we set on the previous step.

Now when you either edit or add a visitor you can select the option from the drop-down

list in the visitor details pane.
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3.7.4.2 Column Attributes

For most tables available within the CardExchange® Visitor database it is possible to

customize the column attributes.

Below are the options for the efPerson table used to store all of the visitor details, however

the same principal is valid for all of the other available tables as well.

List Options

List visible Specify whether the column is visible in the names list of the

visitors pane

List index Specify the sort index of the list item

List header Customize the column header that is shown in the names list

List sort direction Specify a sort direction if required

Search field Specify whether to include the column in search from the names

list search box

Detail Options

Detail visible Specify whether the column is visible in the visitor details pane

Detail index Specify the sort index of the visitor details item

Detail label Customize the column header that is shown in the visitor details

pane

Detail editor Specify the type for the column, for example a text box or date/
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time picker

Detail editable Spedify whether the column in the visitor details pane should be

editable

Default value Specify a default value for a column when adding a new visitor

Required Specify whether a column should be a required field when adding

a new visitor

Mask Setup an input mast for a text box, for example a phone number

format

Control height Specify the height of the text box

Font Options

Font family Specify the font to display for each column

Font size Specify the font size to display for each column

Font weight Set the font weight

Font style Set the font style

Foreground Specify the text color

Drop-down Options

Drop-down table name Specify the table to use for looking up the drop-down values

Drop-down storage

value

Specify the column to use when storing back the drop-down value

Drop-down display

value

Specify the column to use for displaying the drop-down value

Drop-down sort column Specify the column to sort the drop-down items by

Drop-down filter

column

Specify the column to use as the filter for drop-down items

Drop-down filter value Set the filter value to use to when looking up drop-down items

3.7.5 Authorizations

User Authorizations are created and setup for a reason, and that reason is security. From

the Standard edition of CardExchange® Visitor, we offer advanced user authorizations

with login functionality. 
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In order to create more control for the Administrators of CardExchange® Visitor, we offer

the ability to create user authorization levels. This helps limit user infractions and protect

areas within CardExchange® Visitor that the common user should not be utilizing. This high

level security allows you to protect the software and functionality from user errors.

Setting up User Authorizations does not make any sense if you are not using a login

mechanism therefore the first step is to select the Enable logins feature as indicated

above. 

When selecting a dialog will prompt for confirmation.

When you confirm this feature, the User Account Setup Wizard will start.

In the section Create User Authorization  we will explain how to create the user groups,

profiles, and users. To disable the User Authorizations, uncheck the Enable logins

feature check box, a dialog will pop up,  select Yes to disable the functionality.
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Authorizations are only available starting with the Standard edition which allows adding/

managing users, then from the Business edit you can also add/manage groups.

3.7.5.1 Create User Authorizations

Creating User Authorizations starts with creating and/or managing groups. In this first

page of the wizard you find two important areas; The Group information group, indicated

with the red rectangle, and the Authorizations general settings, indicated with the blue

rectangle. The explorer on the left side shows all the available and created groups.

Important! There is always one group available; the Admin group. This group cannot be removed.

With the Authorizations general settings group you can indicate when the passwords

need to expire. For example, putting in 30 means that after 30 days all users, when they

login, are requested to change their password. When leaving it to 0, passwords will not
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expire.

In the Group information section you see the Group name and the Group description. It also

contains the Add and Remove button. To Add a new group, click on the Add button.

You can now enter the Group name, make sure you chose logical names, and a Group

description. 

The new created group will appear in the explorer on the left side as indicated.

In this example we have created a group for data entry, and a group for badge production.

There are no limitations on the amount of groups you can create.

If you want to delete a created group, just select the group in the explorer on the left side

and click on remove. Confirm with Yes to delete! Deleting a group does not delete your

users! 

When you are done adding groups you can proceed to the next level of the wizard by
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clicking Next.

User Management

In this page of the wizard you can create new or edit existing users of the system. On the

explorer on the left side you can find all the available users, on the right side you can find

all the user information.

When you click on Add, to create a new user, you will need to provide a User name, this is

the name used to login to CardExchange® Visitor, enter a Full name of the user, and enter

a Password and Confirm the password.

Just like in the Group Management page of the wizard, we also have one special user;

Admin. The Admin account cannot be removed! What you can change is the password of

the Admin user and we advice to do so but keep in mind changing the password means

that you need to remember the password. There is no option to retrieve or reset the Admin

password.
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The default user name for the Administrator account is Admin and the Password is

Admin too! Passwords are case sensitive! 

Important! The Administrator has always access to all defined groups and users!

In the area indicated with the red rectangle, you find two special options. If you want the

user to generate their own password, just check the box User must change the password

at next login. This can be handy if you have a lot of different users to create but you do not

want to send out all these different passwords. When you select this option, you can simply

use a standard password which first needs to be changed before the user can login to the

system. If you have, like in this example, a group account it is better not to use.

Disabling the user is also a handy option. By checking this box, the user cannot login to the

system anymore but is not removed from the system. If later the user needs to get access to

the system again, simply uncheck the User is disabled box and access is granted again. 
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In the section indicated with the blue rectangle you can specify per user to which group it

will be assigned. Each user can be assigned to one or multiple groups. In this example, it

makes sense that the Production user is assigned to the Badge Production group but you

can imagine that some users need to have access to multiple groups.

When you have created or edited all your users of the system and assigned them to the

correct groups, you can proceed with the Authorizations management on the next and

final page by clicking Next.

Authorizations management
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In this last page of the wizard can assign and create the profiles per defined group or

specific user. In the explorer on the left side you can see all the created groups. If you click

on the expand sign  you can see the assigned users of the group.

On the right side, you have nine separate sections dividing the available CardExchange®

Visitor functionality. When you click on the expand sign for each section, the corresponding

functionality will be shown. For example, in the Data section, all options for finding/

importing/exporting are shown. Each section and each functionality has a check box

indicator. There are basically three options

 No access to functionality

This means that the functionality is not available in the interface. It is not greyed out, it is

totally removed.

 Access to functionality
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This means that the functionality is available for the user of the system.

 Administrator or selected users and groups only

This means that the functionality is either enable at a group level, or it is functionality that

cannot be disabled (Such as the "About CardExchange® Visitor" button)

Besides creating the policies for the groups, each separate user can have some aditional

rights besides the group profile. Simple select the user name from the explorer on the left

and set the aditional authorizations for this user.

When you have defined all the groups, users, and assigned to the functionality allowed for

this group and/or user, you can click on Finish to store your account definitions and close

this wizard.

3.7.5.2 Users Login Access

When User Authorizations is enabled, every time CardExchange® Visitor starts, the user

have to login. If it is a new account, it can be that the Administrator has set the option to

change the password at first login. When that is the case, the the standard login window

will appear as show below:

When the user enters his User name and password, and the Administrator has set the option

to change the password at first login, the message as shown below will appear:

To confirm this action you have to click OK and the Change Password window will appear:
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Enter a new password and confirm the new password and click on OK. If the User name and

Password match, CardExchange® Visitor will load.

3.8 View

Under the view tab it is possible to set the language for CardExchange® Visitor, restore the

view to the previous or default view and to hide the Visitor-details pane,badge-preview

pane, Actions pane if it is not required.
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3.9 Assist

With the release of CardExchange® Visitor we bring unique innovation to your desktop by

offering everything that you need to produce cards in a fast and secure way at hand in 

CardExchange® Visitor Assist.

Help, Forum, Videos, etc., it is all available in this section of your CardExchange® Visitor

product. When you enter the Assist view by selecting the corresponding tab, you will

directly see an Outlook style interface showing on the left the available news items and on

the right the content of this news item.

CardExchange® Visitor uses this section to keep you informed about new updates and

release plans so you will always be able to run the latest version. But also the reseller who

has sold the product to you will keep you informed about his latest and greatest.

Take a look at the separate subjects in this  section of the Help file and see how this is

going to benefit you!
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4 Working With Events

In the Events view you can carry out all the operations associated with Events, you can add/

edit events, use filters to show upcoming events and add new visitors, etc.
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4.1 Layout

The Events view has two panes that can be moved, resized or hidden based on the users

preferences.

· The Events pane (Shown above in red) shows a list of all the events.

· The Event details pane (Shown above in blue) shows all the available data for the

selected event including Invitees.
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4.1.1 Events Pane

In the Events pane of CardExchange® Visitor you see all the events presented that are

available in the database. In the configuration tab you can set the Look-up columns that are

displayed in the Events pane.

Record Sorting
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The Events pane is a so called data grid showing all your available events divided by

columns. Sorting the events is just as simple as clicking on the column. 

Record Look Up
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It is very simple to search for records inside the Events pane. Enter the text that you want to

search for in the text box directly above the columns. 

Loaded Record Information
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In the footer of the Events pane the total amount of loaded records is shown.
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4.1.2 Event Details Pane

The Event details pane shows the main details for the selected event including start/end

times, the organizer of the event and earliest check-in/expiration times.

Also shown in the tabs at the bottom are the invitees, the selected rooms for the meeting,

any documents that are required to be signed and the lobbies that can be used.

4.2 Home

From the Home tab of the Events view it is possible to carry out the most common

functions required in the use of CardExchange® Visitor. 

In this section of the Help file we will go over all the functionality available like adding

events, using Filters etc.
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4.2.1 New event

Clicking on New event  will open the New event window.

Here you can enter all the details for the event, set start and end dates and select invitees/

groups.
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Clicking on Select invitees allows you to select visitors from the list and add them to the

event.
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And clicking on Add invitees by group allows you to select groups to add to the event.

When clicking on Select Lobbies and Rooms you can select the room to be used for the

event as well as the lobbies where the visitors can check-in.
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Clicking on Select Documents will allow you to choose documents that are required to be

signed for the specified event. More information on this can be found here .

4.2.2 Edit

Event details can be edited in four steps:

· First select the event from the Events pane that you wish to edit.

· Then either click on Edit event from either the Home tab.

· Click on the detail you want to edit and change it, you can also amend the invitees

if you need to.

· Click on the Save & Close button to save the data into the database, or on the

Cancel button if you do not want that.
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4.2.3 Filters

The filters section allows you to filter the list of events that is shown in the events pane.

The following filters are available and can be used in combination with each other:

All events This is the default option and shows all events in the database

Today's events Shows all events for the current day

Next seven days Shows all events for the next seven days

Show incidental visits Include incidental events in the events list

4.3 Data

CardExchange® Visitor offers many ways to view and Manage events etc.

In this section of the Help file we will go over all the functionality available like searching

for and editing events, etc.

4.3.1 Using Find

In the Find section of the Data tab you can find the functionality Find. If you select this

option, you enter a dialog window in which you can enter a combination of letters or digits
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to search on (only alphanumeric characters).

If you then click OK, the first element from the list of names that contains the requested

combination is selected.

If the first match is not the one you are looking for, you can search on the same

combination by clicking the Find next button in the Find section of the Data tab. You can

repeat this until you have found the correct person.

The advantage of searching in this way is that the text you enter does not need to be at the

start of an element in the events pane. The search does not make a distinction between

uppercase and lowercase characters.

With this Find function, all elements in the Events pane  remain visible. Any restrictions to

the number of records that are displayed, which would normally apply as a result of what

you have entered in the text field, are overruled.

4.3.2 Using Keyboard

The find functions that have been discussed in the section Using Find  are also available

from the keyboard. You can display the window Find by simultaneously pressing the 

control key and the letter f. You can repeat the search as often as is required to find the

correct person by pressing the F3 function key.

4.3.3 Refresh Data

It is possible that you cannot find the intended record because it has only just been entered

into the database. The details of the record in question have already been entered into the

database, but CardExchange® Visitor has not yet, as it were, seen it. You can solve this

problem by selecting the Refresh data option in the Find section (or by pressing the F5
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function key). CardExchange® Visitor will retrieve the list of records from the database

again.

Doing this ensures that the most recent data for the record concerned is displayed.

4.4 Configuration

Under the configuration tab you can set some advanced options, create/edit buildings,

lobbies and rooms, add documents to be used during checking, change settings for the

database columns and setup authorizations.

4.4.1 Advanced Options

Clicking on Advanced Options will show a window where you can changes some advanced

settings of CardExchange® Visitor.
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In the Advanced Options window you can set the requirements for each separate discipline

of the application, just simply select the tab and change the settings. 

Click Here  to view the Advanced Options section of this help file where you can find an

explanation of what the settings are for and how to configure them.

4.4.2 Layout

Under the Layout section of the ribbon it is possible to edit the column attributes  such

labels, font sizes, text masks etc. as well as select the look-up columns and detail columns

that are displayed.

You can also configure drop-down values  to be used for columns where data entry is

always from a selection of values.
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4.4.2.1 Column Attributes

For most tables available within the CardExchange® Visitor database it is possible to

customize the column attributes.

Below are the options for the efEvent table used to store all of the event details, however

the same principal is valid for all of the other available tables as well.

List Options

List visible Specify whether the column is visible in the events list of the

events pane

List index Specify the sort index of the list item

List header Customize the column header that is shown in the events list

List sort direction Specify a sort direction if required

Search field Specify whether to include the column in search from the events

list search box

Detail Options

Detail visible Specify whether the column is visible in the events details pane

Detail index Specify the sort index of the events details item

Detail label Customize the column header that is shown in the event details

pane

Detail editor Specify the type for the column, for example a text box or date/
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time picker

Detail editable Spedify whether the column in the events details pane should be

editable

Default value Specify a default value for a column when adding a new event

Required Specify whether a column should be a required field when adding

a new event

Mask Setup an input mast for a text box, for example a phone number

format

Font Options

Control height Specify the height of the text box

Font family Specify the font to display for each column

Font size Specify the font size to display for each column

Font weight Set the font weight

Font style Set the font style

Foreground Specify the text color

Drop-down Options

Drop-down table name Specify the table to use for looking up the drop-down values

Drop-down storage

value

Specify the column to use when storing back the drop-down value

Drop-down display

value

Specify the column to use for displaying the drop-down value

Drop-down sort column Specify the column to sort the drop-down items by

Drop-down filter

column

Specify the column to use as the filter for drop-down items

Drop-down filter value Set the filter value to use to when looking up drop-down items

4.4.3 Authorizations

The Authorizations section is the same as mentioned in the Authorizations  section of the

Working With Visitors.
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4.4.4 Buildings

CardExchange® Visitor Business Editions support the creation of unlimited buildings for

your facility.

When clicking on Edit buildings you can change the name of the default building, as well

you can add additional buildings if required.

You can provide a name for the building as well as a description.

4.4.5 Lobbies

CardExchange® Visitor Business Editions support the creation of unlimited lobbies for your
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facility.

When clicking on Edit lobbies you can change the name of the default lobby, as well you

can add additional lobbies if required.

You can also select the Building ID where the lobby is.
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By clicking on Edit rooms you can also edit the rooms that can be accessed through the

selected lobby.

And you can also select those rooms to be available for selection when creating a new
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event.

4.4.6 Rooms

CardExchange® Visitor Business Editions support the creation of unlimited rooms for your

facility.

When clicking on Edit rooms you can change the name of the default room, as well you can

add additional rooms if required.

You can also select the Building ID where the room is.
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By clicking on Edit lobbies you can also edit the lobbies that allow access to the selected

room.

And you can also select those lobbies to be available for selection when creating a new
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event.

4.4.7 Documents

With CardExchange® Visitor Business edition you can ensure that your company has every

visitor sign required documents, such as a non-disclosure, prior to entering the premises.

4.4.7.1 Designing a Document

CardExchange® Visitor utilizes the powerful Merge fields feature within Microsoft Word to

allow for easy merging of data into documents. The user is able to define custom

mappings between merge fields and person details. 
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4.4.7.1.1  Adding Merge Fields

Merge fields are a powerful feature within Microsoft Word that allow for easy merging of

data into documents. CardExchange® Visitor utilizes this feature by allowing the user to

define custom mappings between merge fields and person details. 

Use the following procedure to insert merge fields into a Word document:
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Inside Word, place the cursor in the position where the merge field is to be added.

Head to the Insert tab -> Quick Parts -> Field…

The Field dialog window is now shown. Choose “Mail Merge” from the “Categories”

combo box.

Choose “MergeField” from the “Field names” list box.

Enter the desired merge field name in the “Field name” text box and click “OK”. The

merge field is now displayed in the document as «FieldName» (see “Merge field

mapping example” for a detailed example).

Repeat steps 1 – 4 to insert more merge fields.

Note: Refer to “Importing and configuring documents” for steps on defining the mappings between merge fields

and person details.

4.4.7.1.2  Adding Signature Lines

Every document used within CardExchange® Visitor must include a signature line so that

the person’s digital signature can be inserted into the document. Digital signatures provide

proof that the document was signed, by whom it was signed, the signing date and time,

and whether the document has been modified since its time of signing. Use the following

procedure to insert a signature line into a Word document:
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Inside Word, place the cursor in the position where the signature line is to be added. Head

to the Insert tab -> Signature Line. The signature line is now added. The above is what the

signature line looks like.

4.4.7.2 Importing and Configuring Documents

Before documents can be linked to events, they must be imported into the application. To

import a document into CardExchange Visitor, head to the Events view -> Configuration

tab -> Edit documents.
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The “Edit documents” window is brought up. This window is used to import new documents

into the application and edit existing documents:

1. To begin importing a new document, click the “New” ribbon button.

2. The Location text box is highlighted red—this is because a document location must

be specified.

a. Location is a required field—a new document cannot be added without

specifying its location on the computer.

b. Consequently, the “Save” ribbon button is grayed out, signifying that the

document cannot be saved without first choosing a file location.

3. The small button to the right of the Location text box brings up the Open file dialog.

Locate the desired document on the computer and click “Open." The Location text

box now displays the path to the chosen file.

4. If the document selected in the previous step contains merge fields, the “Merge

field mappings” area is now populated with the merge field names.

5. Click the “Configure mappings” ribbon button to bring up the configure mappings

dialog.
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a. For each of the merge fields in the left column, choose the desired mapped

person property by selecting it from the corresponding combo box.

b. Click “Accept” to save the current mappings or “Cancel” to discard them. The

“Merge field mappings” area in the “Edit documents” window is now updated to

reflect the changes.

i. Now when a document is shown during the check-in process, the visitor’s

information for each of the chosen properties will be shown in place of the

corresponding merge field in the document.

6. Now it is time to configure the rest of the document details:

a. Description—this is a short name for the document that will be shown

throughout the application (such as when adding documents to events). Enter

something here that will allow the document to be easily identified.

b. Required for incidental check-ins—when checked, all visitors checking in without

a planned visit will be required to sign this document.

c. Required by default—when checked, this document will automatically be added

to all newly-created events, and cannot be removed from events.

d. In use—this box must be checked in order for this document to be accessible

throughout the rest of the application. When left unchecked, this document will

not show up in the list of available documents during event creation. 

This is useful for easily hiding documents that may not be used anymore without

having to delete them from the application.

7. Once all of the document details have been configured, click the “Save” ribbon

button. The document is added to the list in the left column of the window.

8. If needed, repeat steps 1 – 7 to import more documents. When finished, close the

“Edit documents” window by clicking the “X” in the top-right corner of the window.
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4.4.7.3 Adding Documents To Events

Open the “New event” window by heading to the Visitors view -> New item -> New event

(alternatively, go to the Events view -> New event). This brings up the “New event” window.
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If any documents have been configured as “Required by default”, they are automatically

linked to the event and displayed in the Documents list.

1. To add documents to this event, click the “Select documents” ribbon button. This

brings up the document selection dialog window.

a. To link a document to this event, select the document in the “All documents”

column and click the “Add” button. The document is now moved to the

“Selected documents” column.

i. Note: Documents not configured as “In use” will not show up in this window.

If a desired document cannot be found, make sure its “In use” field is

checked in the “Edit documents” window (refer to “Importing and

configuring documents ”).

ii. Note: Documents configured as “Required by default” will automatically be

displayed in the “Selected documents” column. Additionally, they will be

marked with the text “REQUIRED”. These documents cannot be removed

from the event. Attempting to remove a required document from the

“Selected documents” column will result in a popup warning, and the

document will remain in the “Selected documents” column.

140
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b. Once the desired documents have been added to the “Selected documents”

column, click “Accept” to save the current selection or “Cancel” to discard it. The

Documents list in the “New event” window is now updated to reflect the

changes.

2. Continue configuring the rest of the event details and click “Save & close” when

finished.

4.4.7.4 Check-in Process

The check-in process requires visitors to sign any documents that may be required for the

event that they are checking in for.

1. To begin the check-in process, select the visitor in the Visitors list of the Visitors view

and click “Check-in” (located in the Actions group of the ribbon or the Actions

pane). If any documents are required, the “Sign documents” wizard is shown.

a. The top-right corner of this wizard displays the index of the current document as

well as the total number of documents required for this event.
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b. The current document can be printed by selecting the “Print” button. This brings

up two printing options:

i. Quick print—if a default printer has already been selected, the document is

immediately sent to that printer. Otherwise, the print dialog is shown, and

the selected printer becomes the default printer.

ii. Advanced print—this always shows the print dialog, which allows specifying

which printer to send the document to, which pages to print, as well as the

number of copies to print.

2. Click the “Sign” button to display the signature pad using the default signature

device (to change the default signature device, head to the Visitors view ->

Signatures tab -> Signature options and select the desired device). Once the

signature is captured, a check mark replaces the “Sign” button.

3. If more documents require signing, click “Next” to continue.

a. You can go back at any point to review previous documents.

b. Clicking “Cancel” at any point will halt the check-in process, and the visitor will

not be checked in.

4. Once all documents have been reviewed and signed, click “Finish” to complete the

check-in process.

a. Each document is now saved in the configured Documents folder (default: C:

\Users\Public\Documents\VisitorExchange\Documents). The folder structure

inside the Documents folder is Company\Event\Invitee. Navigate the appropriate

company, event, and invitee folders to locate the documents.

b. Each document is saved as an encrypted PDF. When attempting to open one of

these documents, a prompt is shown asking for a password to be entered. Two

types of passwords can be entered: Document Open Password or Owner

Password. Depending on which is entered, different permissions are granted:

i. Owner password: All permissions (modifying, copying, standard and high-

resolution printing, content accessibility) [default: “owner”]

ii. Document Open Password: No permissions [default: “password”]

c. Clicking on the signature in the document displays the signature properties:
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4.4.8 Email Notifications

CardExchange® Visitor Business Edition is offering email notifications to each Invitee of an

event when the event is created, also an email notification is sent to the host of the event

each time an invitee checks in to that event.

Above is an example of the email that is sent out to the invitee, depending on the barcode

scanner being used at the lobby this can either be scanned from a print out or scanned

from a phone or tablet device.

Scanning the barcode at the lobby will automatically select the relevant record on the

screen so that you can take a photo, edit any details etc.. and check the person in.

If you also have the CardExchange® Visitor Kiosk application then visitors can self check-in
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by scanning their barcode at the kiosk and following the on-screen instructions.

4.5 View

Under the view tab it is possible to set the language for CardExchange® Visitor, restore the

view to the previous or default view and to hide the Event-details pane if it is not required.

4.6 Assist

With the release of CardExchange® Visitor we bring unique innovation to your desktop by

offering everything that you need to produce cards in a fast and secure way at hand in 

CardExchange® Visitor Assist.

Help, Forum, Videos, etc., it is all available in this section of your CardExchange® Visitor

product. When you enter the Assist view by selecting the corresponding tab, you will

directly see an Outlook style interface showing on the left the available news items and on

the right the content of this news item.
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CardExchange® Visitor uses this section to keep you informed about new updates and

release plans so you will always be able to run the latest version. But also the reseller who

has sold the product to you will keep you informed about his latest and greatest.

Take a look at the separate subjects in this  section of the Help file and see how this is

going to benefit you!
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5 Working With Reports

In the reports view you can select one of the available reports to either preview on the

screen or to print out.

You also have some settings to control the zoom/width/number of pages etc..
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5.1 Evacuation Report

In the event of an emergency you can click select the Evacuation report to quickly preview

and print out a report of all visitors currently checked-in.

The Evacuation report shows the key information for each person currently checked-in, this

includes the following.

First name Shows the persons first name

Last name Shows the persons last name

Mobile phone Shows the persons mobile phone number

Disabled Shows whether the person is disabled or not

Disability If the person is disabled then their disability will be shown

Photo Shows the persons photo

Event Shows the event that the person is attending, otherwise it will show

Incidental visit

Host Shows whether the person is the host of an event or not
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5.2 Visitor History

The Visitor History report allows you to select any visitor and see a history of all their visits

including check-in/check-out dates and a description of their visit. 
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5.3 Event Invitees

The Event Invitees report allows you to select any event and see a list of all Invitees for that

event, their check-in/check-out dates and a description of their visit. 
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6 Working With Assist

With the release of CardExchange® Visitor we bring unique innovation to your desktop by

offering everything that you need to produce cards in a fast and secure way at hand in 

CardExchange® Visitor Assist.

Help, Forum, Videos, etc., it is all available in this section of your CardExchange® Visitor

product. When you enter the Assist view by selecting the corresponding view, you will

directly see an Outlook style interface showing on the left the available news items and on

the right the content of this news item.

CardExchange® Visitor uses this section to keep you informed about new updates and

release plans so you will always be able to run the latest version. But also the reseller who

has sold the product to you will keep you informed about his latest and greatest.

Take a look at the separate subjects and see how this is going to benefit you!
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6.1 Help

You have access to the online help file directly by clicking on the Help button indicated

with in blue.

Our online Help files are always up to date and contain examples with each available

functionality. On the left side you see all the available and selectable subjects, and on the

right the content of the selected subject. Of course you need to have an online internet

connection. When no internet connection is available, the internal Help file will be loaded:

We always strive to have the internal Help file updated to with the latest release but unfortunately we cannot
guarantee this. 

6.2 Forum
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Unique for our industry is our end-user forum. On this forum you can find information from

and by other users of CardExchange® Visitor.

Take a look at all the recent topics and search for solutions you need. Is your solution not

available, just register yourself and post it on the forum. Besides other high level users of

CardExchange® Visitor, all our support and our developers are answering forum questions.

Are you looking for answers and solutions? This is the place to be. Don't forget, by posting

your questions you are not only helping yourself, you are also helping other users of

CardExchange® Visitor!

6.3 Video Tutorials

Sometimes it is handy to see how things are done in stead of reading text or other



CardExchange® Visitor Manual158

© 2016 CardExchange Solutions, Inc.

information. Therefore CardExchange® Visitor offers a large selection of How-To Videos in

our Video Tutorials section.

In this section you can find videos about installing CardExchange® Visitor, activating

your license, Adding new visitors, creating new events, taking photos, etc.

6.4 Upgrade Your License

In the section Activation and Registration  we have explained how you activate your new

CardExchange® Producer license. When you decided that you want to upgrade to a higher

edition, and you have ordered the upgrade, you have probably received a new serial

number and activation code via email from your reseller.

To get to the higher edition, you will have to activate the new license first. To activate your

upgrade, click in the Activation Window button indicated and the CardExchange® Visitor

15
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License Activation Wizard will start.

Enter the serial number and activation code into the text boxes and click on Activate to

start the process.
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If needed you can make changes to your previous registration information, if not, click Next

to proceed.
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If you would like to be contacted, just select how and when, and your reseller will contact

you on the preferred date selected. You can also change your subscription to our

newsletter.

Click Next to proceed to the Final page of the activation process.
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When you click on Finish, the dialog below will pop up prompting you to restart.

Click on OK to confirm and restart CardExchange® Visitor.

6.5 Update Your Registration Info
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When you have registered your software, you can always update your registration

information. Click on the Register License button indicated and CardExchange® Visitor

License Activation Wizard will start.

The registration process is a part of the activation process and therefore the same process

is used. It does not effect your license information, only your registration information.

Now change the information you want to change and proceed to the Next page when

done.
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If you would like to be contacted, just select how and when, and your reseller will contact

you on the preferred date selected. You can also change your subscription to our

newsletter.

Click Next to proceed to the Final page of the Registration process.
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6.6 About CardExchange™ Visitor

Sometimes when you need support you will be asked which edition and version you are

running of CardExchange® Visitor. All this type of information can be found in the About
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CardExchange® Visitor section. Just click on the button indicated , and the window below

will be presented:

In this window you can find the edition and version you are running. This can be important

to see if you are running the latest version with regards to solved bugs.

You also can see your serial number which enables us or your reseller to request your

activation code, if needed. It also contains the Client code of your license. The Client code

indicated who has supplied your license. Last but least, it shows the Machine ID, the digital

fingerprint of your computer for your CardExchange® Visitor license.

When you are running an Enter edition for example and you would like to know what type

of functionality is offered in other editions of CardExchange® Visitor, just click on the 

Compare editions button indicated and it will bring you to the Compare editions section

on our website:



Working With Assist 167

© 2016 CardExchange Solutions, Inc.

Here you can see all the offered functionality available for each separate edition.

6.7 Contact Information

All CardExchange® Visitor Resellers and Distributors have a long history in the Visitor

Management market and can advice and help you to make the right choices. But

unfortunately it is not always easy to know for the user of our software who supplied the

software and were to go to for support.

With the release of CardExchange® Visitor we have solved that problem for you. At the

section indicated you always find one button, this button contains the Company Logo of

the CardExchange® Visitor partner that supplied you the software and if you click on the

button, it will directly take you to their home page so you can find their contact

information.

When applicable, in the same section you can find a second button, that will take you
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directly to the web shop of our partner so you can buy upgrades, supplies, etc.

Together with all the other functionality offered in our Assist section, we strive to offer high

quality with high service without limitations.
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7 Using the Card Designer

With CardExchange® Visitor we use the same powerful designer interface that we

developed for CardExchange® Producer. This card designer follows the latest Windows

technology and is completely developed under the Windows Presentation Foundation

(WPF) platform. For printing graphically, XPS printing technology is used.

The interface look and feel follows the latest Windows and Office look and feel. For the

setup of the functionality we have chosen to follow flow of Microsoft PowerPoint which will

make it very easy to find your way inside of CardExchange® Producer Designer.

CardExchange® Producer Designer is integrated in all editions of CardExchange® Visitor.

When clicking on Card Designer, the CardExchange® Producer Designer will open

mentioning the edition used, showing in Configuration Mode.

As the edition of CardExchange® Visitor increases it will include a higher edition of

CardExchange® Producer Designer, it is also possible to have a higher edition of

CardExchange® Producer Designer with lower editions of CardExchange® Visitor with a

valid license.

So for example you could have CardExchange® Visitor Standard edition along with a
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CardExchange® Producer Professional license, this would allow you to use conditional

layouts in the Standard edition of CardExchange® Visitor. Or you could have a

CardExchange® Visitor Standard edition with a CardExchange® Producer Ultimate license

to allow you to use contactless encoding.

In this "Using the Card Designer" section of the manual we will refer to the editions of

CardExchange® Producer.

The following is a guide to the CardExchange® Producer Designer functionality that is

available as default in each edition of CardExchange Visitor®.

CardExchange® Visitor Edition CardExchange® Producer Designer Features

Enter Go

Standard Premium

Business Professional

Enterprise Ultimate

All configuration is done in the Card Designer via easy drag and drop functionality (click

functionality and drag it to the card design, the need for creating variables is limited to

only very specific functionality like scripting (Available only in the Ultimate Edition).

Talking about scripting, the Card Designer (Ultimate Edition) contains full Python scripting

language. General information about Python can be found by CLICKING HERE. For more

detailed information about Python please CLICK HERE.

http://docs.python.org/2.7/
http://ironpython.net/documentation/
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7.1 Explorer Menu

Just like in the Main Interface , the Card Designer also contains

an Explorer menu. Also here the Explorer Menu is based on the

Explorer Menu as it is available in Microsoft® PowerPoint.

This Explorer Menu contains three tabs which are described in sub

sections of this Help file.

The Explorer Menu gives an overview of all your created layouts,

pages, connected data, etc.

7.1.1 Pages

When selecting the Page tab (default) all available and created

Layouts and the available pages per layout are shown.

Simply click on the page or the layout header to select. Specific

settings for the available Layouts can found in the Page Setup

section of this Help file.

How to Add Layouts  and Pages  can be found in these

specific sections.

22
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7.1.2 Outline

When the Outline tab is selected you find a quick overview of all

the available objects on the pages, in the Layouts, in the

Template.

It is presented as a tree view and by hovering over each available

object, a preview of the object is shown like in the screen shot,

hovering over the Photo object shows the preview of the Photo.

7.1.3 Data

The Data tab is offering, depending on the edition used, four sub

tabs:

· Database columns

· Manual Entries

· Variables

Not all tabs are available in every edition. 

173
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7.1.3.1 Database Columns

This tab contains all the available columns of the connected

database.

Simply select the item and drag and drop it on your card design.

Specific Properties can be set in the Properties  window.202
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7.1.3.2 Manual Entries

All defined Manual entries are available in the Manual entries tab.

You can drag and drop these fields onto your Page layout.

Please visit the Manual Entries  section of this Help file for

more information about creating and configuring Manual Entries.

7.2 Ribbon Overview

Following the structure of Microsoft® Office, the Home tab reflects all the most common

functionality needed.

Clipboard functionality for easy Copy, Cut, and Pasting. In the Font group you can easily set

the font type, size, color, and outline the text.

CardExchange® Producer offers almost unlimited possibilities to outline your text and

objects. Also borders can be easily set and colors can chosen.

The main objects for inserting are also available from the Home tab in the Insert group.

Last but not least, the Properties  window is called from the Home tab too.

It is also possible to minimize the ribbon if you need more space on your design because

229
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you are using a smaller screen.

Right mouse click on one of the available tabs to open the context menu and select 

Minimize the Ribbon.

Now you only see the headers of the tabs and more space is offered. Clicking on the tab

will have the Ribbon information expand. After selecting the functionality it will close

again.

To restore the Ribbon, simple right mouse click on one of the tabs and deselect Minimize

the Ribbon from the context menu. 

7.2.1 Insert
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Just like in the Home tab, objects can be selected here. 

When running a Professional or higher edition, it is also possible to add an extra Layout

which needs to be selected here. When using multiple layouts you can set a condition for

each layout to be automatically shown based on the value of a database column.

Via the Insert tab you can insert the following objects:

· Text

· Images

· 1D Barcodes

· 2D Barcodes

· Rectangles

· Ellipses

· Lines

IMPORTANT! The Layout button is not available in the Go and Premium Edition. Multiple Layouts are supported from
Professional and higher.

7.2.2 Page Layout

The Page Layout tab reflects the first tab (Page) of the Page Setup window. If you want to

add a Background color or Background Image, you can add this via the Background button.

More information about the Page Setup can be found in the "Page Setup " section from

this Help file. More information about how to use Backgrounds, please refer to our "Using

Backgrounds " section of our Help file.

7.2.3 View

When the View tab is selected, you find two different groups:

Group Function(s) Description

242
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Zoom Zoom in Zoom in on the current page

Zoom out Zoom out on the current page

100% Zoom to 100%

Fit template Zooms the page that it fits the window

Fit width Zooms the page that the width of the page fits the width of

the window

Fit height Zooms the page that height of the page fits the height of

the window

Options Language Change the display language of the Designer (Designer

edition only)

Inches Change the display units to inches

Centimeters Change the display units to centimeters

Pixel Change the display units to pixels

.

7.2.4 Service Center

The Service Center tab is organized in different groups with specific functionality. 

This is the same as for the Assist tab in the main interface but this time focused around

CardExchange® Producer Designer.

Group Function(s) Description

Refresh Refresh Refreshes the available news items

Help Help Opens this online help file

Forum Opens our FREE End-User Support Forum

Video Tutorials Opens our website at the How-To Video section

Licensing Activation Window Opens the Activation Wizard window

Register License Opens the Registration Wizard Window

About Compare editions Opens the website at the compare editions section

About CardExchange Opens the About dialog containing license and

machineID info

[Vendor] Vendor Opens the vendor's website

Vendor store Opens the vendor's web store (if applicable)

For more detailed information about the Service Center, please visit the "Assist " section of this Help file...

15
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7.3 Page Setup

To start the Page Setup window, click on the Page Setup button in the Main Menu .201
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7.3.1 Page

For each selected page in your layout, specific settings can be made. For example, if you

are having a double sided print with two pages, the front page can be set to Landscape

and the backside can be set to Portrait.

 

Margins

· Enter the page margins

Orientation

· Change the orientation for landscape or portrait

Print options

· Set the print options for the layout
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· Select printable for graphical printing the page

· Select or deselect Backside to print or not print the backside

· Select magnetic stripe if magnetic encoding is used

7.3.2 Template

Every Card (Template) designed with CardExchange® Producer can contain multiple

layouts and multiple pages. Each Layout  and Page  can have it specific settings but

the template itself holds some specific information like the connected printer being used to

print the different pages.

In this section you can define all the specific template settings like selecting the printer

being used, card size, etc.;

237 240
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Card size

· Printer - Select the printer to be used

· Card size - Select the specific card size

· Width, Height - Enter custom card sizes

Rows and columns

· In this section you can define how many columns and rows need to be printed on

one page. If you set the Number of rows to 3, 3 records will be printed on, for

example, the front page of the card. This technology can be used to print multiple

records for, for example, the use of breakable cards. See more information about

how to use Rows and Columns .

Print options

· Print backside first - Select this option if the backside of the card needs to be

printed first

· Print last card first - Select this option if you want to print the last card from the

batch first

· Print using the GDI+ print engine - Select this option for non-compatible XPS

printers to ensure highest print quality. For more information CLICK HERE .

· Enabled pre-rendering of objects into the background image - For more

information CLICK HERE .

· Send to printer as bitmap - Select this option if you want to have CardExchange®

Producer create a bitmap image first and send it to the printer in stead of sending

all objects separately

7.3.2.1 Using GDI+ Printing

CardExchange® Producer is developed using the latest Microsoft technology and uses their

XPS printing engine for printing. XPS is the technology that has mostly replaced the printer

driver technology as it has been used since the beginning of Windows.

Unfortunately not all ID card printer manufacturers supply drivers that support XPS

technology. Therefore CardExchange® Producer also offers a GDI+ print engine. 

When ID card printers do not support XPS printing can this result in bad quality of images
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and problems with resin printing, to prevent this the GDI+ printing support is enabled as

default.

As CardExchange® Producer uses advanced graphical objects that sometimes are not

supported by GDI+, you can use this technology in combination with Pre-rendering  of

objects. 

If your printer supports XPS printing then it is recommended to uncheck both the options

below:

· "Print using the GDI+ print engine"

· "Enable pre-rendering of background objects"

7.3.2.2 Pre-rendering of Objects

This option enables pre-rendering of objects into the background image of the layout

page. When selected, all objects that have been flagged for pre-rendering, together with

the background image or brush of the layout page, will be rendered to a bitmap image

and sent as such to the printer.

By default, only image objects are flagged for pre-rendering, but on the Visibility  tab of

the Properties window, pre-rendering can be enabled or disabled for any individual object.

Pre-rendering is needed when printing via GDI+ if your design uses graphics that are not

supported by the GDI+ print engine.

Pre-rendered objects will always show behind any other objects in the printed result, even if

that is not the case on the preview.
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7.3.3 Expressions

The CardExchange® Producer Designer integrates a powerful script language that offers

users a high level of flexibility when it comes to personalizing their card layouts. Instead of

assigning fixed values to layout or layout-page properties, it is possible to control their

values through expressions that yield different results in different circumstances. For

example, CardExchange® Producer can inspect a field in the database and then decide to

set a different background color, or even  show a completely different card layout.

The Expressions tab of the page-setup window allows for specifying expressions for the

layout condition, a number of layout-page properties and any number macro commands. 

The layout condition is available for the Professional and Ultimate editions. The layout-

page properties and the macro commands are only available in the Ultimate edition.

Expressions are written in IronPython (see http://ironpython.net), which is the .NET

http://ironpython.net
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implementation of Python, (see http://www.python.org). Since the documentation of Python

is publicly available on these websites, this help file will limit itself to explaining how

Python can be used within CardExchange® Producer and giving some practical examples.

Layout condition

When a card template consists of multiple layouts, the layout-condition property can be

used to determine whether a layout applies or not. Imagine, for example, that the template

has two layouts and that we type

layout == 'A'

for the layout condition of the first layout. When pressing the Enter or Tab key or clicking

OK, CardExchange® Producer will detect that a new variable called 'layout' was introduced

and prompt for a default value. You could set the default value to 'A', as shown in the

screen shot below. 

Now close the page-setup window, select the second layout and open the page-setup

window again. Type in the Expressions tab the layout condition

layout == 'B'

CardExchange® Producer will not prompt for a default value anymore, because the

variable 'layout' is already part of the variables collection. Now, when you close the

designer, open the mappings window and map the Visible item 'layout' to a field in the

database, the first layout will be shown for records that have the value 'A' in that field, while

the second layout will only show if that field contains 'B'.

Layout conditions can be controlled by expressions that are much more complex than this.

The expressions can contain functions and they can use multiple variables. It is possible to

define the layout conditions in such a way, that for some records multiple layouts apply and

for others no layout at all. CardExchange® Producer will print multiple cards for the same

record if multiple layouts apply. If no layouts apply, CardExchange® Producer will skip the

record when executing a print batch.

Background

Three layout-page properties can be controlled by expressions: the background color, the

margins and the page orientation. Background colors are specified using HTML color

names ('AliceBlue',  'AntiqueWhite', 'Aqua', etcetera) or using HTML color tags, for example,

'#FFCD853F', specifying the alpha, red, green and blue channels respectively. The simplest

http://www.python.org
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way of getting a flexible background color is by just typing a variable name in the

expressions box, like

backgroundcolor

CardExchange® Producer will prompt again for a default value, where you can type, for

example, 'AliceBlue'. In the mappings window, the variable name will appear among the

visible items and can be mapped to a database column that contains the desired color

name for each record.

If the color is determined by a flag that does not reflect the color name directly, it is

necessary to define a function in the Functions tab, like for example

def getcolor(flag):

if flag == 'A':

return 'Red'

elif flag == 'B':

return 'Green'

else:

return 'Blue'

This function can be used in the expression for the background color by typing

getcolor(flag)

where the variable 'flag' should be mapped to a database column that can contain the

values 'A' or 'B'. As a result, CardExchange will show a red or green background if that

column contains the value 'A' or 'B' respectively. he background will be blue for all other

values.

Padding

The padding is the space between the edge of the card and the printed area, more

commonly designated as margin when talking about pages. It is not commonly controlled

by expressions. The result of the expressions should be either an integer value that specifies

the width of the margin in pixels, or a string containing two or four numbers, optionally

separated by a comma. The string '10 20' or '10,20' would set a margin of 10 pixels on the

left and right sides and a margin of 20 pixels to the top and bottom sides. The string '1 2 3

4' or '1,2,3,4' would set a left margin of 1, a top margin of 2, a right margin of 3 and a

bottom margin of 4.
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Page orientation

For the page orientation, it is still more unlikely that you want to control it with an

expression. The value that the expression should return are 'Landscape', 'Portrait',

'ReverseLandscape' or 'ReversePortrait', where the last two refer to an orientation that has

been rotated 180 degrees.

Macro commands

Macro commands are text strings that are sent to the printer as printable characters, but

that are interpreted by the printer as special commands. The most common application of

macro commands is using them for magnetic encoding. The printer recognizes text strings

as macro commands by inspecting the first and sometimes the last characters. For example,

on certain printer brands, the string '~1%XXXXX?' is interpreted as a command to encode

the characters 'XXXXX' on track 1 of the magnetic stripe.

Although you could define macro commands for magnetic encoding in the Expressions tab

of the page-setup window, you normally will not do that, because it is much more user

friendly to enable the magnetic-stripe object in the Page-layout ribbon and configure it in

the properties window. However, some printers support other types of macro commands,

for example for defining holographic overlays, in which case you can manually add those

commands in the page-setup window.
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7.3.4 Variables

When expressions are used to determine property values, CardExchange® Producer detects

whether any variables were used in the expression. If so, it prompts for default values and

adds the variables to the template's variable collection. If you select the Data tab of the

Explorer Menu, the template's variables will appear and their values can be mapped to

external data, like database columns or manual entries.

The Variables tab in the page-setup window, lists the complete variable collection and

allows for following actions:

§ Changing a variable name by clicking on it in the list and typing a new name. If you

rename a variable, be sure that you also adapt any expressions that are using that

variable.
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§ Changing the default value of a variable by typing in the value box.

§ Removing a variable by clicking on the button with the red cross. You should only do

this if you are sure that the variable is not being used by any expressions.

§ Adding a new variable by clicking on the Add-variable button.

If you want the default value of a variable to represent an image, you can click in the image

button to show some additional controls that helps you defining the image.

The select-image button allows you to select an image file from the computer. The point-

to-file check box allows you to set the default value to the file path instead of the image

data.

When you hover over the image, you see two additional buttons that are for editing and

removing the image respectively. Please, note that edited images cannot be of the point-

to-file type. When you edit a point-to-file image, the point-to-file box will be unchecked

automatically. On the other hand, if you check the box for an edited image, the image will

revert to the original one.
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7.3.5 Functions

The Functions tab in the expressions window shows a single text box where you can type

any global definitions you want to use in your Python scripts. When typing here, you need

to follow the Python syntax (see http://www.python.org). Normally, you will use this space

to define custom functions to be used in expressions. An example shown before was the

function we defined to determine the background color

def getcolor(flag):

if flag == 'A':

return 'Red'

elif flag == 'B':

return 'Green'

else:

return 'Blue'

http://www.python.org


Using the Card Designer 191

© 2016 CardExchange Solutions, Inc.

It is also possible to define global variables, that is, variables that can be used in

expressions or functions, but that will not be listed under the visible items. For example, we

could change the above function definition to

colorA = 'Red'

colorB = 'Green'

colorC = 'Blue'

def getcolor(flag):

if flag == 'A':

return colorA

elif flag == 'B':

return colorB

else:

return colorC

To get a taste of the level of complexity you can achieve with custom functions, see the

below definition of a function that converts a string to name casing. It uses the regular-

expressions module of Python (see http://www.python.org for more information).

import re

def namecase(s):

return re.sub('\w+', capitalizematch, s)

def capitalizematch(m):

return capitalize(m.group(0))

def capitalize(s):

if len(s) > 1:

return s[:1].upper() + s[1:].lower()

elif len(s) == 1:

return s.upper()

else:

return s

With the name-case function, you can convert a string like 'jOHn SMith' into 'John Smith'.

http://www.python.org
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7.4 Magnetic Encoding

Magnetic encoding with CardExchange® Producer is very easy to configure. Just check the 

Magnetic stripe check box in the Page layout  tab or select Page Setup from the Menu.

Select the Page tab and check the Magnetic stripe check box.

176
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In the Page design you now see a red magnetic stripe rectangle appearing as indicated.

Now make sure that you have the Properties  window open and make sure the Content

 tab is selected and that the magnetic area on your page design is selected.

202

204



CardExchange® Visitor Manual194

© 2016 CardExchange Solutions, Inc.

In the Properties window you now see three sections:

· Magnetic encoding

· Track 1, Track 2, and Track 3 

· Start and stop sentinels

Magnetic encoding
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In this group, indicated with the red rectangle, you select which track you want to write to.

Just select the check box for each track to make it available. In the text box next to the

Track you can directly enter information (fixed value) or drag a database column into it. For

each selected track the track object, indicated in the orange rectangle, will become

available.

Track 1, Track 2, and Track 3

In this group, indicated with the orange rectangle you can set or change the information

that is being coded to the magnetic stripe. Click on the  to expand the Track info.
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Just like with normal objects, with the Magnetic Encoding you can also use the Standard

Object Types  to connect.

Start and stop sentinels

258
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All ID Card Printers are using start and stop sentinels for moving the card into encoding

position. Although encoding of magnetic cards is based on an ISO standard, the commands

used are mostly different per manufacturers brand.

To make sure you are using the correct start and stop commands, the most common

commands are available via CardExchange® Producer directly. Just select the printer you

are using from the printer drop down menu and click on Apply defaults.
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If you are using specific start and stop sentinels, you can directly enter them into the text

boxes.

7.5 Rows and Columns

CardExchange® Producer offers the possibility to print multiple records on a your card. This

can be very handy when printing, for example, breakable cards for key chains.

Select the Layout , open the Page Setup  window, and select the Template tab. Here

you can find the Rows and Columns section. Enter the amount of columns and rows you

want to use. For example, using one column and 3 rows will have the following print result:

236 178
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Of course, because CardExchange® Producer supports Windows printers, you can also use

this to create face books for your A4 or Letter printers.
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7.6 Templates

As you have read in the Designer Interface  section of this Help

file, all your configuration is done in the Card Designer. Therefore

the CardExchange® Producer Designer works based on

templates.

To understand how CardExchange® Producer works, it is

important to take special note of this section of the Help file.

Basically every time you create a new card with CardExchange®

Producer you are creating a new Template.

With the Designer you always create a new or open the selected 

Template. But it is always ONE Template!

Each Template has always one ID Card Printer connected, one

Database connection, one MIFARE® Classic or DESFire

connection, one External Plug In, etc.

Each Template can have have Multiple Layouts. In the screen shot

you see "Layout1" and "Layout2". These are the layouts inside the

template. Each layout can have it's own unique conditions like 

Magnetic Encoding  settings. By selecting the layout, you can

simply call the Page Setup  window from the Main Menu  to

set the specific conditions.

This offers very powerful functionality. Using Multiple Layouts

inside one Template makes if for example, possible to automatic

switch between the different available Layouts within the

Template. More information how to create this type of

functionality can be found in the Expressions  section of this

Help file.

More information about Layouts can be found in the "Adding

Layout(s) " section of this Help file.

Each Layout can have Multiple Pages. You can have a Page for the Front Side, a Page for the

Back Side, but also a Page for a UV panel on the Front and/or a UV panel on the Back. Each

Page holds all the objects like text, image, barcode, etc., objects.

169
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7.7 Menu Overview

In the Main menu of the Designer you can find all common functionality needed to save,
print, etc., your card. 

In the Designer menu you can load the page setup, print the template, and save the
template.

Available functionality

· Save Save the template and/or the modifications you made

· Print This menu has three sub items:

· Print (Select the printer, the amount of copies, etc.)

· Quick Print (Send the template directly to the default
printer without making any changes)

· Print preview (Preview and make changes to pages
before printing)

· Page setup
Opens the Page Setup window. More information about Page
Setup can be found in the "Page Setup " section of this Help
file

· Export This menu has five sub items and allows you to export the card
layout as an image. You can export different formats like BMP,
JPG, PNG, etc.

· About
CardExchange®
Producer

This opens the about window with version information of
CardExchange® Producer

178
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· Exit This will exit the Card Designer and close the Configuration
mode

7.8 Variables

The variables in the CardExchange® Producer designer can be

used as input for Python scripts and their value can be mapped to

for example a database column or a manual entry. Mappings are

made via the Content  tab in the Properties  window.

Please visit the Variables  section of this Help file for more

information about using Variables.

Variables are available in the Ultimate edition.

7.9 Properties

All objects used with the CardExchange® Producer Designer have way more properties as

shown in the Add Object window. All these properties are available in the Properties

Windows. Click on the Properties button in the Home tab to open. In the Properties

Window you can find specific properties for:

· Content

204 202
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· Position

· Text

· Border

· Colors

· Visibility

· Database Columns

· Manual Entries

· Expressions

· Variables

· Functions
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7.9.1 Content

In the content tab you can enter information when you are using a Fixed Value  object.

This information will then be presented on the Page design in the Text  object. Of course

when connected to a database, this Content tab will show the data from the connected

column. The box around the text area will be GREEN when it contains information coming

from a connected database, ORANGE when it contains Manual Entry information, and RED

when it contains information from Scripts. When using fixed text, it will have no color and

look like the screen shot.

262

242
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You can change the information by selecting a different Standard Object Type . But can

also be set for using photos, signatures, etc. More information can be found in the "Using

Images " section of this Help file.

In stead of selecting a Standard Object, the information can also simply be changed by

selecting a database column from the Data Menu  in the Explorer Menu  and drag and

drop this field directly into the Content text area.

Formatting Options

The Content tab also offers the possibility to do some advanced formatting. In the

Formatting Options group you can set the Letter case for the content. You have four options

for the Letter case:

· Maintain Original - No changes to the original

· Lowercase - Makes the content Lowercase

258
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· Uppercase - Makes the content Uppercase

· Namecase - Makes all the first letters Uppercase

You can add a prefix and a suffix to your content and make it always visible. By default it is

unchecked which means that if there is no content available, for example from the

database, the prefix or suffix information will not shown.

You can also set the Format of the content. This can be handy if you want to make sure that

it is always a integer, date, text, etc., content. You can select the following Formats:

· Date/Time

· Decimal

· Floating Point

· Integer

· None

· String

You can also format the content based on kinda script. For example in the screen shot we

entered 'd4'. That means that the content will be representing four digits. So if the value

from the database is 1, setting it to d4 will show 0001.

No bringing it all together, the screen shot with the specific settings will represent the

follow information on the card to be printed:
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7.9.2 Position

In the Position tab you can set the specific position, sizes, and margins. Of course you this

reflects the position on the Page as you dragged and dropped it so what is the need. In

some situations you will have to set the positions, sizes, and margins based on specs

provided by the customers. In stead of trying to accomplish this with a very stable hand,

you can here directly enter the values.

Also the Horizontal and Vertical alignment can be set. Set the preferred stretch setting and,

if applicable, enter the rotation angle in degrees.
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7.9.3 Text

In the Text tab you can set the Font Type and the Font Size in the Font Group. Besides the

alignment options, you can set the Font Stretch. The Font Stretch is not the same as the text

stretch because it determines the intense of the font when stretching while the standard

stretch just make sure the text fits in the text box. With the Font Stretch you can choose

from:

· Normal (Default)

· Ultra Condensed

· Extra Condensed

· Condensed
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· Semi Condensed

· Semi Expand

· Expand

· Extra Expand

· Ultra Expand

In the Text Layout you can set the Maximum number of lines for the text object. That means

if you set, for example, the value to 2, it does not matter how large the text object on the

page is, it will only use maximum two lines for the text. If you do not use stretch

functionality, it will not fit the box if it over exceeds 2 lines.

Bringing it to the Stretch option. Stretching and Stretch Direction combines the perfect

functionality to get good results in your text object on the Page. In the Stretch Drop Down

Menu you can select:

· None (default)

· Fill

· Uniform

· Uniform Fill

In the Stretch Direction you can select:

· Up Only

· Down Only

· Both

Now, for example, when selecting the option Fill in the Stretch Drop Down Menu, in

combination with the Down Only option from the Stretch Direction Menu, the Font will be

re-sized horizontally only.

Text Object without Stretch

Text Object with Stretch set to Fill, Stretch Direction to Down Only
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In stead of using Stretch functionality, you can also trim the text. There are basically three

options for text trimming:

Text Object without Text Trimming

Text Object with Character Ellipsis Text Trimming

Text Object without Text Trimming

Last option in this Text property is setting the Line Height. By default this is not disabled

and it uses the standard line heights for the Font Type. In some situations it can be that the

standard will eat up to much space you have available on Page Design. When you select

the check box, the text box right next to it becomes available and you can enter a value for

the line height. The value used is depending on the settings you made in the Options

section in the View  tab, centimeters, inches, or pixels. See example below:

Text Object without using Line Height

176
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Text Object using 0.10" Line Height

7.9.4 Border

In this section of the Properties Window you can set the properties for the borders of the

objects. In the first group you can define all the values for the Border thickness. For

example, when adding a rectangle object to your Page Design, you can select the border

thickness from the Home menu in the Border section:
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You can also enter this directly in the Border Thickness section of the Border tab. This is

handy if you need to set specific values provided by your customer.

For example, we add a photo object on the Page Design and set the values for entering to

pixels in the Options section of the View  tab. This object looks like below:

Now we set the Border Thickness to 5 pixels for the Right and Bottom:

176



CardExchange® Visitor Manual214

© 2016 CardExchange Solutions, Inc.

Now the photo object will look as below
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Now you get totally fancy by combining this with the Corner Radius. For example, we set

the Corner Radius for the Top-Left and the Bottom-Right to 25 pixels and see the result

below:

This can be done with all existing objects available with CardExchange® Producer. It even

can become more advanced if we are combining the objects borders with colors and

backgrounds. More about this in the Colors  section of this Help file.

Last but not least, when using Text Objects you can use padding. Padding is the space

inside the object and is therefore not the same as Margin as that is the space outside of the

object.

Text Object without Padding

Text Object with Left and Top Padding

216
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7.9.5 Colors

Depending on the object used on the Page  design, different color options are available

divided in three different groups:

180
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· Foreground brush - sets the foreground color of the object

· Background - sets the background color for the object

· Border brush - sets the border color for the object

Each group offers four different style options:

·  Transparent

·  Solid color

·  Gradient

·  Image

Colors can be selected directly from the drop down menu as indicated with the red arrow:

Picked from the color selection area as indicated with the blue rectangle:

Created by moving the color sliders to the preferred position as indicated with the orange

rectangle:
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Or directly entered into the text boxes right from the color sliders as indicated with the

purple rectangle:

There are so many possibilities to combine that it is impossible to explain them all. We

have created a couple of examples which are explained in the sub sections of this Color

subject.

7.9.5.1 Text Object Example

For this example we added a text object to the Page design and set the colors as shown

below:
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The foreground color is set to blue and for the background color we used orange with a

gradient style which creates the result below:
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7.9.5.2 Image Object Example

For this Image Object example we added a Image of a photo to the Page  design and

created a border via the Border  tab. We have set the system to use pixels and we have

the set the properties as following:

Now the Image object on the Page  design looks like below:

180
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What we will do now is replace the Solid Color Border with an Image that we will load.

In the Border brush group we select the Image style as indicated with the orange box and

we select an image by clicking on the Select image... button as indicated with the red

rectangle. When the image is loaded, the Page  design will show the following result:180
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7.9.6 Visibility

The Visibility tab contains three separate group sections:

· Visibility

· Opacity mask

· Background removal

Visibility

In the visibility group you can set the opacity of the image on the Page design. This can be

used to create ghosting images. For example, as shown in the screenshot, see the

differences in the images shown below:
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No Opacity Opacity 50%

Besides setting the opacity for the image, you can also select the visibility of the image as

well the printability. Each drop down menu offers three selections:

· Visible

· Hidden

· Collapsed

Opacity Mask

With the Opacity mask you can do some great and advanced stuff. For example, we have

created an opacity mask using the gradient tool and the background color orange.

Now take a look at the photo images below. On the left you have the original and on the

right the photo with the opacity mask.
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No Opacity Using Opacity Mask

But you can also load images or use solid colors.

Background Removal

CardExchange® Producer offers advanced background removal. Use the sliders to define

the correct removal. You can also enter the values directly into the text boxes right from

each color slider. For example, we removed the background based on the slider

configuration below.

Now take a look at the photo images below. On the left you have the original and on the

right the photo with the background removed.



CardExchange® Visitor Manual226

© 2016 CardExchange Solutions, Inc.

No Removal Background Removed

It is important to realize that the result of the background removal depends on the quality

of the image and the used background. Always try to use real blue or green backgrounds

when taking photos as this offers the best removal result.
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7.9.7 Database Columns

All of the database columns are available in the Database columns tab of the Properties

 window. 

Just like with the Manual entries , these database columns can be directly drag and

dropped to the Page design via the Data tab of the Explorer menu.

202
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7.9.8 Manual Entries

To add a manual entry, select the Manual entries tab of the Properties window.

And click the Add manual entry button indicated with the red arrow.
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When the Entry is added, you start with entering a name for the label, indicated with label1.

For example, DOB (Date of Birth). Next you enter a value in the value1 field. This can be, for

example, a value like 100 if you are using the entry to always store the same value.

Now when you are done adding your Manual entries, they will become available for adding

them to you Page  design in the Data  tab of the Explorer  menu.

When you select the Data  tab of the Explorer  menu, you will see the Manual entries

tab as indicated. When you select this tab, the added Manual entries become available as

shown in the blue rectangle. Now you can simply drag and drop them to your Page

design.

180 172 171
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This can also be done from the Manual entries tab in the Properties  window.

7.9.9 Expressions

IMPORTANT! Expressions are supported in our Ultimate edition only!

The Expression tab of the Properties  window makes it possible to control any property

of a Page object by means of a Python script, a Database column or a Manual Entry.

To control an object property with a script, select the object and enter the Python script in

the text box next to the property name. For example, select a text object on the card layout

202
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and enter the following script for the Background property of that text object (in this case

the script is just a single variable name):

vColor

After pressing Enter, the designer will prompt for a default value for the script variable

vColor. Here you can type, for example:

Red

After closing the pop-up window, the background of the text object will be red. The text

box where the script was entered will show a red glow to indicate that this value is now

controlled by a script. Changing the value of the script variable in the Variables  tab of

the Properties  window, will make the background color of the text object change

accordingly.

For any script defined in the Expressions tab, it is important that the result value can be

converted to the correct data type. CardExchange® Producer recognizes many text

representations, like ‘Red’ in the above example. Please, note that CardExchange®

Producer recognizes the standard color names as well as the HTML representation of a 32-

bits ARGB color, for example:

#FFFF0000

Scripts can only contain a single line of code. For that reason, it will generally be necessary

to define functions in order to get program more complex functionality. For the 

Background property, one can, for example, define the following function in the Functions

 tab (For more information about Functions , please see the Functions  section in

this Help file).

def IsValid(s):

  if s == 'OK':

    return 'Transparent'

  else:

    return 'Red'

With this function, the script for the Background property can look like

IsValid(vStatus)

If the variable vStatus has the value ‘OK’, the background of the text object will be

188
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transparent, and red otherwise.

It is also possible to control the value of a property directly by a database column or

manual entry, without the intervention of a script. This can be achieved by dragging and

dropping a database column or manual entry from the Data tab of the main window and

drop it on the text box in the Expressions tab. Database-column mappings are

characterized by a green glow and Manual Entries by a yellow glow.

7.9.10 Variables

IMPORTANT! Variables are supported in our Ultimate edition only!

Whenever a script is typed in the CardExchange® Producer designer, the variables used in

that script are automatically added to the template. With the Variables tab it is possible to

see all variables that have currently been defined and manage their properties. The
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following actions are possible:

· Rename a variable by clicking on its name and typing a new name.

· Change variable’s value by typing in the text box next to its name.

· Set the variable’s value to an image by clicking on its image button and selecting

an image.

· Remove a variable by clicking on its remove button.

· Add a new variable by clicking on the Add-variable button.

· Connect a variable to a database column by dragging the column from the Data

tab and dropping it in the text box

· Connect a variable to a manual entry by dragging the column from the Data tab

and dropping it in the text box

· Create a text object on the card layout content is mapped to the variable by

dragging the variable name from the Variables tab and dropping it on the card

layout.
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7.9.11 Functions

IMPORTANT! Functions are supported in our Ultimate edition only!

In the Functions tab, it is possible to define global variables, functions and references

that can be used in Python scripts. By using well-defined functions, the scripts in the

Content  and Expressions  tabs can be kept consistent. It would not be possible to use

much of the power of Python in scripts, if you could not define functions.

A function definition should strictly follow the Python syntax as described in the Python

documentation. An example of a function is:

def IsValid(s):

  if s == 'OK':

    return 'Transparent'

  else:

204 231
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    return 'Red'

This function returns either ‘Transparent’ or ‘Red’ depending on the value of the input

parameter s.

Global variables can be defined in the Function tab with a simple assignment statement.

Once defined, they can be used in functions and scripts. For example, instead of the above

function, we could make the following definition, with the global variable warningColor:

warningColor = 'Red'

def IsValid(s):

  if s == 'OK':

    return 'Transparent'

  else:

    return warningColor

Finally, the Functions tab can be used to reference Python modules, in order to use them

in functions and scripts. The following example imports the .NET Framework System

module and uses it to re-format a date string:

import System

def FormatDate(s):

  d = System.DateTime.Parse(s)

  return d.ToString('dd-MM-yyyy')

CardExchange® Producer uses IronPython for executing scripts. IronPython is the .NET

Framework implementation of the well-known Python scripting language. For extensive

documentation on IronPython, please visit www.ironpython.org.

7.10 Layouts

As explained in the Templates  section of this Help file, Layouts can contain one ore

more Pages. If you are running a Go or Premium edition, only one layout is allowed. When

running a Professional or Ultimate edition, you can use multiple layouts within your

template.

Layouts are very powerful as they offer you the possibility to change based on information

out of the connected database. Also each layout can have it's own setting like for example,

200
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no magnetic encoding or magnetic encoding.

7.10.1 Adding Layout(s)

Adding a Layout is simple clicking on the Layout button and a new layout will be added.

When adding a layout, it always adds a layout based on the previous layout. So for

example in the screen shot Layout2 contains only one page because Layout1 contains only

one page. If Layout1  had two pages, Layout2 would also have two pages.

Each page can be setup via the Page Setup  window as described in that section of this

Help file.

178
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7.10.2 Edit Layout(s)

For your own convenience it is possible and advisable to rename the Layout(s). When you

right click on the Layout name a context menu will be show and you select Rename. You

can also double click on the Layout name and change it. 
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7.10.3 Delete Layout(s)

You can easily delete a Layout from your template by selecting the Layout and press Delete

on your keyboard. By selecting the Layout and right click on the mouse, in the presented

context menu you choose Delete.

You can always undo your deleting by pressing Ctrl+Z.

7.11 Page(s)

Every Layout can basically have unlimited Pages. A Layout can have for example a Front-

side Page, a Back-side Page, a Front-side UV Page, etc.

Each Page can be set to Portrait or Landscape and of course can have it's own unique

objects.

In this section of the Help file we will explain how to Add pages to your layout and how to

Delete them.
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7.11.1 Adding Page(s)

When you have selected your layout, you can add a page by clicking on the Layout Page

button in the Home tab.

You can also add a Page via the Layout page button in the Insert tab.

Click on Layout page to add the page as shown in the screen shot.
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Each page can be setup via the Page Setup  window as described in that section of this

Help file.

7.11.2 Delete Page(s)

You can delete a page by selecting it and click on Delete on your keyboard or via the right

mouse click content menu, selecting Delete layout page.

7.12 Objects

CardExchange® Producer offers a lot of objects to design your card. From standard text

objects to image objects for photos and signatures to 1D and 2D barcodes, lines, etc.

178



CardExchange® Visitor Manual242

© 2016 CardExchange Solutions, Inc.

Each object comes with a collection of Properties that can be used to customize your

objects to your wishes. The properties of the objects are explained in the Properties

section of this Help file.

In this section we will go over each available object and how to use it.

7.12.1 Text

Select the Text object from the Insert tab or from the Insert section of the Home tab. Click

with the mouse on a location of the page and select one of the available Standard Object

Types from the drop down menu. Select the font type, size, outlining, etc.

For more information about the different Standard Objects, please see the "Using Standard

Objects " section of this Help file.

202
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7.12.2 Image(s)

Select the Image object from the Insert tab or from the Insert group at the Home tab and

place this on the page by clicking on a location on the page.

When the Insert new object window opens, it is default set to Fixed Image. You can also

select Photo , Signature , Variable Image , and Script. You can find more information

about these configurations in the specific sections of this Help file.

When using the Fixed image, you can select an Image by clicking on the Select image...

button. When the image is presented, you can check the 'Point to image file' check box. By

default it is unchecked which means that the image is embedded into the page. If the check

box is checked, a reference to the file is made. The advantage of this is that it keeps your

templates small because it does not contain images, disadvantage is that if the folder that

contains the image is moved or removed, your image will not be shown anymore.

Of course it is also possible to align the image to your wishes. You can align the image

horizontal, vertical, and stretch. 

When you hover over the presented image, you will see two buttons appearing. The 

button will delete the previewed image, the  button will open the ImageExchange®

Editor  to make change to the image.

245 246 247
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More information about using the ImageExchange® Editor can be found in the "Using

Image Editor " section of this Help file.

IMPORTANT! Every object in CardExchange® Producer has many Properties which are not shown in the Insert new object
form. Please see the Properties  section of this Help file for more information about specific use of functionality.

72
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7.12.2.1 Photo(s)

When using photos you can select and dedicate an image to a specific photo field in the

database or a reference to a photo in a folder based on a 'Point to image file' reference.

The process for adding the image is exactly the same as explained in the "Using Images "

section of this Help file.

Select Photo from the object drop down box and the Select database column drop down

box will become available. If you select the ID field of the connected database, the system

will automatically make it a 'Point to image file' connection. It can also that your database

contains the complete reference to image file locations if that is the case, please leave the

Image folder location empty and set the file extension to 'Extension included in source

value'.

The image folder location can be entered directly and it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support bmp, jpg, jpeg,

png, gif, tif and tiff.

You can also set the format of the value coming from the database so you know for sure

there is no mismatch.

243
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If the database contains the image data and you have selected the image column, the

'Point-to-file options' section will be disabled.

Check for more options like colors, borders, visibility, etc., the Properties  section of this

Help file.

7.12.2.2 Signature(s)

IMPORTANT! This Signature option is available from Premium editions and higher!

Starting from Premium, you can select and dedicate an image to a specific signature field

in the database or a reference to a signature in a folder based on a 'Point to image file'

reference.

The process for adding the signature is exactly the same as explained in the "Using Images

" section of this Help file.

Select Signature from the object drop down box and the Select database column drop

down box will become available. If you select the ID field of the connected database, the

system will automatically make it a 'Point to image file' connection. It can also that your

202

243



Using the Card Designer 247

© 2016 CardExchange Solutions, Inc.

database contains the complete reference to image file locations if that is the case, please

leave the Image folder location empty and set the file extension to 'Extension included in

source value'.

The image folder location can be entered directly as it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support bmp, jpg, jpeg,

png, gif, tif and tiff.

You can also set the format of the value coming from the database so you know for sure

there is no mismatch.

If the database contains the image data and you have selected the image column, the

'Point-to-file options' section will be disabled.

Check for more options like colors, borders, visibility, etc., the Properties  section of this

Help file.

7.12.2.3 Variable Image(s)

IMPORTANT! This Variable Image option is available from Premium editions and higher!

202
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Our Premium edition offers a unique feature that allows you to switch images based on a

value of the database.

The process for adding the Variable Image is exactly the same as explained in the "Using

Images " section of this Help file.

Select Variable image from the object drop down box and the Select database column

drop down box will become available. If you select the ID field of the connected database,

the system will automatically make it a 'Point to image file' connection. It can also that your

database contains the complete reference to image file locations if that is the case, please

leave the Image folder location empty and set the file extension to 'Extension included in

source value'.

The image folder location can be entered directly as it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support bmp, jpg, jpeg,

png, gif, tif and tiff.

You can also set the format of the value coming from the database so you know for sure

there is no mismatch.

If the database contains the image data and you have selected the image column, the

'Point-to-file options' section will be disabled.

Check for more options like colors, borders, visibility, etc., the Properties  section of this

Help file.

7.12.2.4 Backgrounds

There are basically two ways to use backgrounds on your page. You can simply add an

Image object to your Page, select the Image to use, and select Fit to page.

243
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A better way to go is using the Background functionality offered in the Page Layout tab.

When you click on the Background button, four options are offered.

Use no color or image...
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Choose from a one solid color...

Use a Gradient color...

Or use a background image.

The advantage of using a background via the Page Layout tab is that it will always make

sure that it completely covers the whole card. As you know, the card sizes vary when using a

Direct-to-Card printer or a re-transfer printer. With a re-transfer printer the print size of the

page layout is larger and using this Background functionality makes sure that your image is

always fitting the page and you will have no white lines with printing.
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7.12.3 1D Barcode

To add a 1D barcode object to you page, just select the Linear barcode button from the

Insert tab and click on a location on the page to place it. Now select the Symbology that

you want to use from the drop down menu. All most common 1D Barcodes are supported.

Standard the Fixed value is selected, for using other values please see the "Using Standard

Object Types " section of this help file.

Of course a lot of extra options are available for the 1D Barcodes but they need to be

access via the Properties  window of the Designer. When the properties window is

opened, select the Content tab.

258
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You can add a checksum, set the options for specific barcodes like Codabar, Code-128, etc.

7.12.4 2D Barcode

IMPORTANT! This 2D Barcode option is available from Premium editions and higher!
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To add a 2D barcode object to you page, just select the 2D barcode button from the Insert

tab and click on a location on the page to place it. Now select the Symbology that you

want to use from the drop down menu. All most common 2D Barcodes are supported.

Standard the Fixed value is selected, for using other values please see the "Using Standard

Object Types " section of this help file.

Of course a lot of extra options are available for the 2D Barcodes but they need to be

access via the Properties  window of the Designer. When the properties window is

opened, select the Content tab.

258
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Just like with the 1D barcodes, a lot of specific 2D barcode options can be set.
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7.12.5 Drawing Objects

Select the Line, Rectangle, or Ellipse button to add it to the page. 

Check for more options like colors, borders, visibility, etc., the Properties  section of this

Help file.

202
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7.12.6 Formating Objects

In the Home tab you can select the font, font size and font color that you want to use for

your object. For more information about formatting of objects, please see our "Properties

" section of this Help file. 202
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7.12.7 Arranging of Objects

CardExchange® Producer offers a lot of functionality to arrange your objects on the page.

All the arranging functionality is available via the Arrange group in the Home tab or via the

Context menu.
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7.13 Standard Object Types

With exception for the Image object, CardExchange® Producer offers Standard Object

Types. Standard Object Types is functionality that can be connected to the object. In this

section we will inform you how to use these Standard Objects Types.

Standards Objects Types can be selected when adding a new object to your Page

designer or via the Content  tab in the Properties  window.204 202
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7.13.1 Concatenation

Concatenation is very powerful functionality offered in CardExchange® Producer. It offers

you unlimited ways to present or store data.

In this example we are adding a new Text object  to our Page  design and we have it

set to the default Standard Object Type, Fixed Value, and we enter a name into the text

area, in this case "Fixed" Now we click on the Concatenate button under the formatting

options.

242 239
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Now we get a new option to select a Standard Object Type, in this case, also a Fixed

Value is used but this can be any Standard Object Type available.

Now you see that the Standard Object Type is changed from Fixed Value to Concatenate

as indicated.

The Concatenations are divided by expandable tabs. When you click on the left down

arrow  it will open the selected one and close the previous opened:
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You also see a red vertical line on the left. This indicates the group of Concatenations.

There are no limitations to the amount of Concatenations you can make. You can always

change your Concatenations in the Properties  window at the Content  section.202 204
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7.13.2 Fixed Value

Select Fixed Value from the Standard Object Type drop down menu, indicated with the

red rectangle and enter the text into the text area. 
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7.13.3 Global Counter

Select Global Counter from the Standard Object Type drop down menu, indicated with

the red rectangle and set the Global Counter options in the group indicated with the

orange rectangle. When using the Global Counter, you see that the text area is indicated

with a green rectangle. This means that the value shown is generated based on the settings

for the Global Counter and cannot be changed in the text area.
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7.13.4 Print Date

Select Print Date from the Standard Object Type drop down menu, indicated with the red

rectangle and it will directly present the date. You can also show the date and time or time

only by setting the date format options. When using the Print Date you see that the text

area is indicated with a green rectangle. This means that the value shown cannot be

changed in the text area.

The date reflect the date and time as available on your computer.
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7.13.5 Script

Select Script from the Standard Object Type drop down menu, indicated with the red

rectangle and enter the script in the text field under the drop down menu.

You will see that the text area is now indicated with a red/orange color which means that

the value shown is calculated based on the script.

IMPORTANT! Scripting is only available in the Ultimate edition.
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7.13.6 Database Columns

In the Standard Object Type drop down menu, all the database columns are available for

selecting. 

When selecting a database column from the list, you will see that the text area is indicated

with a green rectangle. This means that the data shown is coming from the connected

database and cannot be edited in the text area.
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8 Checking-In

When checking on Check-in from either the Home tab or the Actions pane, CardExchange®

Visitor will check to see if the visitor is either marked as a VIP or requiring an escort.
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If either option is checked then the corresponding prompt above is displayed, or the

prompt containing both if they are both checked.

You can then either click ok to continue, or cancel to arrange the escort before checking

them in.

8.1 Visitor Screening

CardExchange® Visitor Business Edition is offering visitor screening via criminal and sex

offender database systems of Amber Road and MK Data Services.

For details on configuring this please see the Visitor Screening  section of this manual.

Before a visitor is checked in, information of the visitor will be sent to the screening services

and when a possible match is made, the window below will be show:

98



Checking-In 269

© 2016 CardExchange Solutions, Inc.

Clicking on more information will direct you to the website of the screening provider so

you can log in and see any additional information that they may hold for that person.

If you choose to continue then you will see a warning asking if you wish to proceed, clicking

yes will check the person in.

If you choose blacklist then the visitor will be added to the Blacklist of the visitor
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management system, you can enter a reason and confirm on the window that is shown.
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8.2 Document Signing

If you have added a document either to the event or as a required document then each

visitor will need to agree to and sign the document at the time of check-in.

If a signature tablet is being used then the document can be digitally signed, otherwise it

can be printed out to be physically signed. 

Once the document has been either signed or printed, you can click on finish to complete

the check-in.

All digitally signed documents are stored in the following location by default:

C:\Users\Public\Documents\VisitorExchange\Documents\
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9 Expired Badges

If Expired badges are shown in the bottom right of the main window, you can click on the

button to give you a list of all the expired badges.
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Here you can select one or more visitors and either check them out if you know that they

have left, or select a time period to extend they stay by.

Some details are also shown for the invitee so that you can try to contact them if needed.

Once you are done click on Apply to save the changes.
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10 Evacuation Report

In the event of an emergency you can click on Evacuation report to quickly print out a

report of all visitors currently checked-in.

This button is always shown in the bottom right of all views to allow quick access to it.
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Clicking the Evacuation report button will prompt you with the print dialog window for you

to select the desired printer, all printers on the system appear so you can print to any

printer you have.
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The Evacuation report shows the key information for each person currently checked-in, this

includes the following.

First name Shows the persons first name

Last name Shows the persons last name

Mobile phone Shows the persons mobile phone number

Disabled Shows whether the person is disabled or not

Disability If the person is disabled then their disability will be shown

Photo Shows the persons photo

Event Shows the event that the person is attending, otherwise it will show

Incidental visit

Host Shows whether the person is the host of an event or not
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11 Auto-checkout

When closing CardExchange® Visitor you have the option to automatically check-out all

active visitors, you can also exit without checking them out or return to the main window.
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12 KIOSK Client

Starting from the CardExchange® Visitor Business edition it is also possible to use the

CardExchange® Visitor KIOSK Client. This is a stand-alone KIOSK application for self check-

in and check-out by visitors.

12.1 Check-In
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On the main screen you have the option to scan the barcode from the event confirmation

email, or if you cannot scan this you can enter the barcode number manually.

If a valid barcode number is either scanned or entered, the details of the event are

displayed on the screen.
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Clicking on next will bring up the visitor details screen, depending on the configuration you

can allow visitors to change incorrect details and take/update the photo.

The next screen displays any documents that the visitors are required to sign before

checking in, if it is a touchscreen kiosk you can sign directly on the screen in the section

under the document.
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You will then see a summary of the event you are checking in for, to complete the check-in

just click on Check-in.

The visitor badge will be printed to the selected printer for the visitor to collect, also if the

event host has an email address configured then they will receive an email notification that
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the visitor has checked in.

12.2 Check-Out

When scanning a barcode on the main screen for a visitor that has already checked-in, they

will be presented with the check-out screen displaying a summary of their event. Clicking

Check-out will check them out of the building.
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12.3 Configuration

To enter the advanced options you need to enter the administrator password on the main

screen, by default this is Admin and can be changed in the general kiosk settings  which

you can access from the advanced options window in the main CardExchange® Visitor

application.

Under the About tab you can see all the detailed information regarding the installed

version, Serial number, MachineID, Edition etc...

96
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From the location tab you can select the location of the Kiosk client, you can select the

current building and lobby.

Under the printing tab you can select the location for the badge template to be used, the

badge printer and the document printer.
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Under the cameras tab you can select the desired camera from the available options.

And you can shutdown the Kiosk client from the shutdown tab.
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